
CPRS Tab-by Tab Training

Topic 1:  Introduction
Welcome to the CPRS tab-by-tab Web-based training module. My name is Rick Hines. I work for the Office of Information Field Office based out of Salt Lake City, remotely located at the White River Junction VA in Vermont. I have a wonderful job supporting CPRS and related software applications. With me today is my friend and colleague Dr. Neil Evans. Neil is a primary care physician at the Washington DC Medical Center, where he is in the trenches every day seeing patients and interacting with CPRS, the primary instrument in his patient care tool chest. If you visit the Washington, DC VA, stop in and see him. He'll be wearing a bow tie and enjoying his coffee and maybe even a donut, while running around like a nut all day long. 

Neil and I met for the first time in 2006 when we taped a similar CPRS tab-by-tab presentation. When Neil and I were developing the content for that presentation, we found an interesting coincidence in our lives. Neil's wife, Rachel, was pregnant and so was my wife, Jeannie. The coincidence though is that they were both pregnant with twins. Rachel was due at the end of September. And my wife Jeannie was due at the end of November.

Well here we are in 2009, three years later, taping a new updated CPRS Web-based training for you. And Rachel and Jeannie, well, they both gave birth to a boy and a girl. Neil and I are now proud fathers. We are extremely happy and overwhelmingly exhausted.  Oh and Neil and Rachel? They will soon join the hat trick club like my family, expecting their third in January 2010.Before we hand the keyboard over to you, I would like to go over a small introduction of the Computerized Patient Record System, the graphical user interface known as CPRS. For this presentation, we will be going over a complete tab-by-tab tour of the CPRS GUI application.  So you don't lose sleep at night I will tell you that CPRS GUI stands for Computerized Patient Record System graphical user interface. I'll also be discussing an overview of clinical context management called CCOW. In addition, our Web-based training includes a detailed section for customizing CPRS with tips and timesavers and also an overview of how to use the iMedConsent program and VistA Imaging display software applications.

So CPRS, what is it? Well, it's an integrated electronic medical record for clinicians, managers, quality assurance staff, and other researchers. We released the graphical user interface of CPRS in 1997. It's a fast and easy-to-use program, which you'll find out shortly. And it brings back information through the use of cohort logic clinical reminders, which we will be going over later as well. And a nice results reporting feature and also a system called expert feedback.

So it is a truly integrated electronic medical record. As you can see by the list of software packages that are all interfaced. It's a complete record, including radiology and lab, pharmacy and dietetics and consults. These and other software applications as well. So why is CPRS so successful? I believe it's due to our dedicated staff.  A highly motivated staff of system design and development. Subject matter expert groups that provide feedback during conference calls for product improvement. Our VA test sites who do an unbelievable amount of work testing this software before it gets released nationally to the field. And then we have our frontline patient care providers, like Neil, that provide feedback to our developers to improve our products. We also have a wonderful National Training and Education Office.  And that's why we're here today. They organized all of this for you. 

We also have teams of people like myself that provide national software support and troubleshooting for our software. I dedicated a whole slide to introduce you to the clinical applications coordinator. These highly motivated individuals are your local CPRS experts. They do all they can to customize CPRS to match your clinical practice. They can create order sets and templates to save you time and they also provide endless training. I hope you will develop a working relationship with the clinical application coordinators at your medical center. Ask them what they can do to save you time for a particular task in CPRS. Sit down with them and have a discussion.  It's not a bad idea bringing some coffee and donuts as an ice breaker either.

This is just a wow slide showing you how the database is growing more and more. Complex orders, documents and digital images as they're captured. I personally find it amazing that the number of digital images has more than doubled in a few years.  Just a few slides to explain an entity called CCOW. CPRS is CCOW compliant. You're going to be hearing a lot about that.  CCOW stands for clinical context object workgroup. It's a protocol that enables software applications to synchronize. In other words share the same patient. When different applications share the same patient, it's known as patient context. CCOW can also provide user single sign-on between applications, and that's known as user context. So why is this important to you?  Well it's nice, because it prevents you from having to select the same patient again when using different clinical applications in the same session. But, I want you to be aware of things that you may want to be careful about. Like how to determine when CPRS is and is not participating in patient context and why it's important to be careful with multiple CPRS sessions open at the same time. 
CPRS will tell you when it is in patient context by the existence of a little blue person with a chain link icon as I have circled in red. CPRS will also tell you when it is not in patient context because you will see a crowd of people with a broken chain link icon.  
Take home message #1: Just be aware when CPRS is not in patient context. You'll know this easily by the visual indicator showing the broken link with the crowd of people. When you see that you'll know that multiple software applications cannot share this patient unless you make CPRS share this patient context by setting new context within the CPRS File menu. If your head is starting to spin, stay with me because we'll be explaining this more during the actual presentation. Just being aware of those CCOW icons represents what is important.

Take home message #2: No CCOW icon is not a good thing either. We sometimes see this when CPRS has started too quickly after logging in to your computer.  A solution is just to simply exit CPRS and start it back up again.  And you should see the blue person icon with the connected chain link.

Finally take home message #3: I'm a very visual person, so for me it helps to have a visual image imprinted on my mind of the CCOW.  So, here you are. Here is the CCOW.  And for extra credit, would you say these two characters are in patient context or not in context?  So this completes the introduction slides of the presentation. Next, we'll begin the Web-based CPRS tab-by-tab hands-on presentation. And as you can see, Neil and I want to make this be an enjoyable experience for you. 
So let's go have some fun.
Topic 2:  Signing on to CPRS / Patient Selection / Patient Record Flags
Welcome to the Veterans E-Health University, VeHU, database for the CPRS tab-by-tab Web-based training.  To sign on, CPRS requires using an access code and a verify code.  I suspect by now 50 people have mentioned to you never to share your codes with anyone, so I am not going to say any more about that.  First, on your computer, we're going to need to find and double-click the CPRS GUI icon.  Keep in mind, for this Web-based training, you will be unable to double-click, right-click, and resize within this training.  However, we will demonstrate these actions so that you can use them in the CPRS system. Alright, so on my desktop, I'm going to locate and double-click the CPRS GUI icon.  It looks like a little chart, a half-opened chart.  

When I do that, a splash screen will display, which shows you the current version of the software, and then you will be presented with a sign-on window which challenges you for your access and verify codes. Also, many VA hospitals use this sign-on window to pass on informational messages to you so you may want to read what that sign-on message text says.  Your access and verify codes that have been given to you are not case sensitive in this application.  For this Web-based training, we will be signing on as Dr. Vehu Zero.  Your access code is 00VEHU, that is 0-0-V-E-H-U.  And the verify code is VEHU00.  So let's enter your access code, 0-0-V-E-H-U. Now to get the verify code input box we could press the Tab key or we could just simply place our cursor in there using the mouse. Let's do that.  Let's select the verify code input box with our mouse. And enter your verify code,  V-E-H-U-0-0.

And to this point we could select to change our verify code by selecting the checkbox next to change verify code  but we're not going to do that.  Go ahead and select the OK button. Timesaving tip I'd like to give you right now is you could have entered your access code, then a semicolon, then your verify code all within the input box for the access code and then just simply pressed the enter key. Wham, the chart would open.  That simply eliminates the need to move the cursor into the verify code input box. However, only use my semicolon trick if you are not going to change your verify code this session, because to change your verify code you are actually required to enter it within that verify code input box. Okay, we have just signed onto CPRS using your access and verify codes.  In this section, we're going to go over the Patient Selection screen, which is displayed to us right now.  There are basically three areas on this screen that I want to bring your attention to. 

The first area is an input box located in the top center portion of the screen under Patients All Patients.  That input box is where we would put our patient's name to open up the CPRS chart. On the uppermost left-hand portion of the screen are some radio buttons labeled Providers, Team/Personal, Specialties, Clinics, Wards, and a button for All.  These radio buttons allow us to default a list of patients based on this selection criteria. We'll go over this shortly. In the bottom area of this screen, there's a listing of notifications. These notifications are used to alert us about results on our patients like lab or imaging. Or they can show us items that may need our signature like unsigned notes, uncosigned progress notes, or just general notifications on medications nearing expiration.  These notifications can also alert us to flagged orders and admission and discharge notifications.  Dr. Evans, a true notifications and CPRS guru, will be discussing processing notifications later in this presentation.  

So let's bring your attention up to those radio buttons.  I'd like you to select the radio button next to Providers. When you do that, a list box opens up with the list of providers in our hospital.  Select Provider Eight. If you look over to the right under the Patients list box now, two patients show up there: Five Inpatient and  Seven Inpatient.  During a VA admission, the admitting clerk is asked to enter the primary physician as well as an attending physician for the admission.  This provider button in CPRS returns the patients that were admitted and assigned to that primary physician, which in most cases is the resident physician.  So these two patients are showing up in the listing because  Dr. Provider Eight was assigned as the primary physician for these patients for the admission.  Note that we could save this list of patients as our default list by simply selecting the Save Patient List Settings button.  Note that there are radio buttons to default to personal team or an assigned treating specialty as your default patient list as well.  We're going to bypass these for now.  Let's move over to the other side of the radio buttons and select the Clinics radio button.

Again, a list of clinics show up in our hospital. I will place our cursor in the input box, which is located right above the audiology clinic.  This is going to allow us to type in the name of a clinic.  Please type in primary care.  Now select the primary care Dr. Vehu clinic.

Note in the "List Appointments for" input area, that the default date range is set to today.  We are going to leave that date range as today, but we could specify a different date range by selecting the little down arrow button.  So now that we have selected our primary care Dr. VeHU clinic for today, we notice that we have about seven patients that have clinic appointments for our clinic.  If we wished this to be our default list of patients, we could select the Save Patient List Settings button.  I think providers will find this very useful in the outpatient clinic setting to actually have CPRS display their clinic patients scheduled for today automatically for them.  But what I do not like about this Clinic radio button setting is that there isn't an easy way to sort the list by appointment date and time.  The list defaults in alphabetical order by patients' last name.  But there is hope.  There is a way to set up a combination list of clinics and/or a ward to use as your default list which allows sorting ability.  I discuss this in much more detail in the Customizing Your CPRS and Tips and Timesavers topic in this presentation.  You'll definitely want to check that out.  Now select the Wards radio button.

Again,  we have a list of the wards in our VeHU hospital, we can select one of those wards.  Let's choose the second one on the list, it's called 3 North SURG. Again, note that there is a button in the middle part of the screen to the right that says Save Patient List Settings. I don't want you to select that button right now, but this is where you would actually save any of these lists as your CPRS default list. So that each time that you signed on to the CPRS chart, a list of patients from the Ward 3 North Surgery, or perhaps your clinic would be displayed for you. It is a great timesaver to have a predefined list of patients listed for you. That way you can select the patient from the short list versus having to keyboard in the patient's last name and Social Security number.  For today though, let's select the radio button next to All.  

This is showing us two things. Patient Twenty displays for us, which is the most recent patient's chart that we had opened. But underneath Patient Twenty's name, there is a line delimiter. And then underneath that line is a list of all the patients in our VeHU Hospital database.  Last name, first name, and they're sorted by the patient's last name.

So how do we choose a patient in CPRS?  There's many ways to do that. We could set up a default list which I just demonstrated and simply select their name.  Or if we have no default list we could simply type in the patient's last name and simply select their name.  Place your cursor in the Patients All Patients input box. And then type in Twenty.

Patient Twenty becomes highlighted. But another thing happened as well. If you look underneath the splitter bar, those patients are all filtered now, beginning with their last name of Twenty. So we have Twenty, Patient, Twentyeight, InPatient, etcetera, all in our database. A very quick and easy way to select a patient is to enter the patient's first initial of their last name and the last four numbers of their Social Security number.  So for this patient, I could have entered  T-0-0-2-0 to select Patient Twenty as well.  Or I could have entered their full Social Security number.

Okay, so now we've highlighted Twenty, Patient.  If you look to the right-hand side underneath their name, CPRS is showing you the patient's full Social Security number, their date of birth, their sex, that they're a veteran, and that this patient is 40 percent service connected. This is an important thing to take note of, because it can assure to you that you're selecting the correct patient. These indentifiers automatically display for you, so you can be sure that you're selecting the correct patient.  An exception to this is if the patient is marked as sensitive in your database.  In that case, the Social Security number and the date of birth would be annotated as sensitive on this identifiers display. 

Another item that is displayed when we highlight the patient's name is if they are a combat veteran.  Note the text, "CV December 31, 2013 OEF/OIF."  This is a visual indicator that this is a combat veteran whose combat vet status expires on December 31, 2013.  And in addition, this patient served in either the OEF or OIF campaigns which are acronyms for Operation Enduring Freedom and Operation Iraqi Freedom.  This indicator will no longer display for this veteran when it expires, that being the day after December 31, 2013.  So we have verified that this is indeed the patient's chart we wish to open, so go ahead and select that patient by selecting  the OK button.

We've selected our patient, but before the chart will open, an informational pop-up dialog is displaying some information to us, trying to get our attention.  This dialog is called a patient record flag.  The purpose of the Patient Record Flags is to alert providers about patients with disruptive, threatening, and/or violent behaviors.

Patient Record Flags can be national, which are considered category I, which are shared among the VA facilities.  Or local flags which are considered category II flags.  In this case, this patient has a category I Patient Record Flag and also a local category II flag. Most of your patients will probably not have a Patient Record Flag.  What I want to bring to your attention though is by default the national category I flag is highlighted and that is what details are being shown to you.  In this case it is a behavioral flag because the patient shows signs of potential violence.  The flag details show when it was assigned and other flag details.  Again, this is considered a category I national Patient Record Flag, because it's shared between all VAs.  But, please note, that to actually display the details of the category II flag, which is high risk for suicide, we actually have to select it.  

So do that.  Please select the category II flag titled high risk for suicide so we can see the details.  When we select the category II flag, we see the details, recent suicide attempt on August 21, 2009.  In addition, Patient Record Flags can be linked to an actual progress note title.  This note is linked, and we can view the details of that progress note by selecting the August 21, 2009 date of the note.  So please do that, select the August 21, 2009 at 10:03 in the bottom section of the patient record flags window.  

The progress note details display for you saying that the patient has been very depressed since his mother passed away on July 1, 2009.  Patient attempted suicide on August 21, 2009 via an overdose of narcotic. Now select the Close button. 

And the display returns to our main Patient Record Flag dialog.  This concludes the CPRS patient selection topic.  Stay with me as our journey continues starting with the CPRS Cover Sheet.

Topic 3:  Cover Sheet Tab
Well, we've selected our patient and also reviewed a Patient Record Flag pop-up dialog.  And now our patient chart has opened up.  We're going to go over each of these sections of the chart.  But before we do that, I would like to show you how to maximize the CPRS chart window to use the most real estate of your screen.  You can control the location and size of the CPRS window with the Windows title bar control buttons located in the far upper right-hand corner of the CPRS chart where you'll notice three very small buttons.  The left button looks like an underscore character, the center button is a square box with the top partially shaded and the rightmost button is an X.  To maximize the CPRS window, select the center button, the one that looks like a partially shaded square.  

The CPRS window maximizes and is now using the most screen real estate that it can.  So now that we've maximized our window and used the most real estate that we can, I'd like to bring your attention to the following items.  There's a File, Edit, View, Tools, and Help menu up above. There is an informational header or title bar that includes a little icon that usually has a little blue person with an unbroken chain link, the patient's name, Social Security number and date of birth, their visit location and provider using CPRS, that's usually your name, the primary care team that's assigned, and other information on that header as well.   I promise to explain each of these in detail shortly. But clinically, the Cover Sheet is showing you your data grids.  The default data grids included on the Cover Sheet consist of Active Problems, Allergies, Patient Record Flags - yeah there they are again - the Postings, Active Medications, Clinical Reminders, Recent Lab Results, Vitals, and the patient's currently scheduled appointments, visits, and admissions.  
Some medical centers may have swapped out one of the default grids with a listing of recent immunizations.  Bringing your attention to the bottom part of the CPRS window, you can see the tabs of the CPRS chart: the Cover Sheet, the Problems, and the Meds, the Orders, Notes, Consults, Surgery, Discharge Summaries, Labs, and Reports.  Dr. Evans and I will be tag teaming these tabs for these presentations, so you are soon to be a CPRS chart wizard.  For the time being, let me show you how you can do some customization of your grids. You can actually resize these data grids.  Note in the Vitals grid that the dates of the vitals measurements are kind of chopped off.  I don't really like that.  Now, you won't be able to resize with this training, so just watch me for now and you can do it later in the CPRS system yourself.  Take your mouse and place it on the vertical gray separator bar located between the Vitals grid and the Appointments and Visits grid.  When you do that your mouse will change to a resize indicator. Now I'm going to hold down the left mouse button and drag that line to the right until I can see the full text of the Vitals grid.  There. You can also resize the grids' length.  It appears to me that not all of the active meds and reminders are displaying because I can see a scroll bar indicator in those grids.  Well, I don't really like that either.  What I'm going to do is place the mouse between the Recent Lab Results grid and the Active Medications grid.  And it will, again, change to are size indicator.  Now I'm going to hold down the left button and drag that separator bar down until I can see all of the clinical reminders and active medications that are listed, without a scroll bar.  This setting will be preserved when we sign on to CPRS from now on.    Okay, so let's start looking at the clinical data of the Cover Sheet.  Let's select the item in the Active Problems grid for acute myocardial infarction. 

It will bring up a list box that shows you more information about that problem, the doctor that entered it, and when it was entered and its status, if it's an active or an acute problem.  Let's go ahead and close this window by selecting the Close button in the lower right-hand corner of that dialog.  

So the next item I would like to select is within the Allergies grid. Select penicillin, please. 

And it will show you that information on that allergy that was entered by the physician.  And this patient has itching and watering eyes for penicillin.  I'll point out that we can actually add new allergies at this point. We're going to do that shortly.  For now, I'd like you to just close this window by selecting the Close button.  Well, do you remember our Patient Record Flags that came up earlier when we first selected this patient?  We can redisplay that patient records flag by going to the data grid for Patient Record Flags on the right-hand portion of the screen and selecting the word, behavioral. Do that for me.  Select the word "behavioral" in the Patient Record Flags data grid. 

There they are again.  We don't need to hash over this again.  Just select the Close button on that dialog.  

I'd like to bring your attention to the Postings section of the chart. Postings can list the patient's allergies and advance directives that the patients might have and also their clinical warning notes that they may have.  These are items that are in a convenient location for you, right on our Cover Sheet.  So under the Postings section, there's a listing of allergy, crisis notes, and a few advance directives.  Let's select the crisis note under Postings.

And so this brings up a progress note with the title of "crisis note."By the way, it's a special type of note that's been set up by a clinical applications coordinator that actually is set to display on the patient's Cover Sheet under this posting section.  A clinical applications coordinator can define certain progress note titles to display in this posting section.  Clinical coordinators are your friends and people you need to know.  I hear they like coffee and donuts.  So let's select the Close button.   

And now let's select the advance directive dated Oct 18, 2000 for this patient.   

And it displays.  You can go ahead and select the Close button for the advance directive.

Let's bring our attention to the Active Medications data grid. The patient's active medications are listed in this grid.  Let's select the warfarin 5 mg tablet.  

Selecting the warfarin 5 mg tablet will bring more information about this medication, who ordered it, when it was ordered, and any changes that were made to this medication.  Go ahead and select the Close button in the medications details dialog. 

So I think you're getting the idea that one nice thing about the CPRS graphical user interface is that you can point and select an item and get more detailed information about it.  Let's bring our attention to the Clinical Reminders area.  Clinical reminders are items that can be programmed by a clinical applications coordinator or a clinical informaticist as well as being exported nationally.  These use cohort logic to tell us when certain things are due on our patient.  For an example, if a patient is a diabetic, good patient care says that a hemoglobin A1c should be performed every year on diabetics.  Another example of a clinical reminder is, patients should be screened for lipid screening every five years if the patient's age is greater than 35. So the nice thing about our Computerized Patient Record System is that we can program in this logic to display these clinical reminders to you as a provider, right on the Cover Sheet.  For example, move into the data grid area for clinical reminders and select the diabetes urinalysis clinical reminder.    

It says that it's due now. And the reason that it's due is, it's due every year for all ages. This patient had a diagnosis of diabetes and this is why this reminder is coming due on this patient.  Close this dialog box by selecting the Close button.   

Let's move down to the Vitals data grid.  I want  to show you how you can graph vital signs.  We'll use blood pressure as an example.  Select the blood pressure vitals under the Vitals grid. It's the one that says BP.

Okay, so now we've opened this dialog box for vital signs and we've selected blood pressure.  But hey, we're not seeing any data to display.  The reason is is our date-range setting.  Let's select two years on the left-hand side of the dialog box under the patient's name. Behold, we have some blood pressure data now.  You can see that the vitals are graphed by interval date ranges.  If we wanted to change that time scale, we could take the check off of the time scale checkbox.  Each date range would then be the exact time sequence as opposed to interval.  You can see that the values are turned on for our blood pressures.  If we wished, we could disable those values by selecting the checkbox next to Values.  So let's do that.  Let's select the checkbox that's enabled next to Values.  

And when we do that, the values disappear from our grid.  Let's turn those back on by selecting the checkbox next to Values.      Also note that the dialog allows us to enter vitals via the File menu or right-clicking in the data grid area or by selecting the Enter Vitals button in the upper right-hand portion of the window.  We're not going to do that at this point.  So now let's just close this Vitals dialog box by selecting the little X box in the upper right-hand corner of the dialog.

I would like to bring your attention to the appointments and visits areas of the data grid.  There is the list of your patient's outpatient clinic appointments for a date range. You will be able to set which date range of appointments you would like to have listed.  I cover how to do this in detail in the Customizing Your CPRS and Tips and Timesavers topic in this presentation.  Take note that the appointment status displays as well to the right of each appointment listed. Our patient has cancelled an appointment and also no-showed for some appointments.  For appointments that are in a checked out status, you can review the written note right from this Cover Sheet.  For example, select the cardiology appointment from August 31, 2009 at 10 o'clock. Look at that.  The progress note displays nicely.  Select the Close button. 

I would like to bring your attention to the allergies portion of this screen now.  Let's take our mouse and right-click somewhere in the grid for allergies.  Again, you won't be able to right-click or double-click right now in this training, so just watch me.  When you right-click, a dialog box opens allowing us to enter a new allergy, mark an existing allergy as entered in error, or mark the patient's chart as no known allergies.  Let's now enter a new allergy on this patient.  Let's select the Enter New Allergy option.  

When we do that, it immediately opens up a Causative Agent Lookup dialog box.  Now we can put in the drug that we're putting in the allergy for.  Let's type in codeine:  C-O-D-E-I-N-E.  And select the Search button.  

When we do that, a search of all the codeine entries in our National Drug File display.  Let's select the one on the list that says, "codeine."And select the OK button. And when we do that, another dialog box opens up, allowing us to enter allergy information for this codeine.  You can see that the originator of this allergy is the doctor that is signed on to CPRS, in this case Dr. Vehu Zero.  Next to that is a radio button for Observed or Historical.  If we had observed this allergy, then obviously we would select the radio button next to observed.  But in this particular case, our patient has told us that they had a previous reaction to codeine. So we will need to select the radio button for Historical.  Please select the radio button for Historical. 

Under the Nature of Reaction pull-down menu, there's a little arrow.  I would like you to select that. 

When you select that, you get a list of the nature of reactions that we can choose for this allergy.  Let's select "allergy" for this particular codeine allergy.  

And now we need to select the signs and symptoms that our patient told us happened when they were given codeine.  In this particular case, I'm going to choose the one halfway down the screen for nausea and vomiting.  And I'm going to double-click that entry.  As you can see, it moves over into the selected symptoms listing.  And now we have selected symptoms for codeine.  We could enter some comments if we wanted to, in the comments input box.  We're not going to do that at this time, but we could.  Let's go ahead and select the OK button and mark this allergy on our patient.  

And sure enough, when we do that, our chart is immediately updated with the codeine allergy.  That was pretty easy.  This concludes looking at the data grids.
Topic 4:  CPRS Informational Header
Let's take our attention up to the informational header of the CPRS Cover Sheet.  This header appears above the content of every tab within CPRS. The informational header consists of buttons, actually.  The first one being the patient's name.  So Patient Twenty is on the informational header.  It shows the patient's Social Security number and their date of birth.  Like I've been telling you throughout the presentation, CPRS is pretty user-friendly.  If you select something, you can get more information.  So please select the patient's name box. A dialog box will open up, which gives you information about the patient, where they live, their full Social Security number again, their employment information and their insurance information.  
We could also select a new patient with this dialog box by selecting those buttons.  But in this particular case, let's just select the Close button. Bring your attention now to the button to the right of the patient's name called Visit Not Selected. You'll notice that the provider that's signed on to CPRS GUI is listed here.  Again it's our virtual colleague, Dr. Vehu Zero.  Let's select that Visit Not Selected button. Now this allows us to select the patient's appointment or visit location to associate all orders and progress notes to for this patient encounter.  It is extremely important to select the proper visit by selecting the clinic where you are seeing this patient.  Clinics are created and scheduled by your medical center administrative staff.  By choosing the correct visit location you are being assured that you and your medical center are getting proper workload credit, billing and decision support service credit for your encounter.  You may have just telephoned your patient, so you would, for example, create a new visit using your telephone visit location name.  Be deliberate, get the proper workload credit for your patient encounter.  As a side note, if our patient was admitted to a ward, the visit is automatically selected for us. 
 I like that.  If earlier, from the Patient Selection screen, you had selected your patient from a predefined clinic list, that visit would already be defined as well.  So you wouldn't have to deal with this dialog.  Since we have had neither of those conditions though, we need to specify the patient's location manually.  For this test patient today, the Clinic Appointments tab has the focus and is allowing us to select a clinic appointment encounter from that list.  We will shortly, but first, select the  New Visit tab.  This would allow you to actually create a new standalone visit automatically by selecting a clinical location from the list of visit locations being displayed.  If we optionally checked the Historical Visit checkbox, the clinic would not get workload credit.  We could use Historical to document past events.  Again, this is where you would not guess on selecting a clinic location.  You may have a telephone clinic location, an initial visit location, and perhaps even a follow-up visit location.  Most of the time, your patients will have a prescheduled clinic appointment, and you would not need to generate a new visit. For today, our patient does have a prescheduled clinic appointment for our primary care clinic Dr. VeHU, so that is the clinic we wish to select.  So, go back on the Clinic Appointments tab by selecting the Clinic Appointments tab. And then select the primary care Dr. VeHU clinic for October 13, 2009.Now select the OK button. Note that the visit location now has actually changed and our associated visit is being displayed to us.  
Okay, we've selected our patient visit location, let's move on.  The next button, to the right of the location button, is the Primary Care Team button. This button lists our patient's assigned primary care provider, the primary care team as well as an attending if our patient is admitted. In this particular case, our patient does not have any assigned, on our test account, so we will just move over that. The next button to the right of the Primary Care button are actually two buttons vertically stacked one on top of the other.  As a side note I should tell you that some of these buttons may not display for your patient.  It depends on their statuses and other database entries that may enable or disable some of these buttons.  Me being the geek that I am, have enabled all of the buttons I could think of to show you their functionality. Bring your attention to the button labeled MHV.  MHV is an acronym for My HealtheVet.  In case you have never heard of My HealtheVet, it is a Web-based application that creates a new, online environment where veterans, family, and clinicians may come together to optimize veterans' health care.  
Web technology combines essential health record information enhanced by online health resources to enable and encourage patient/clinician collaboration.  The value of this My HealtheVet icon is that it provides a quick visual reminder that a patient is an in-person authenticated user, or what is also referred to as an IPA'd user, of My HealtheVet.  This means the patient has Web-based electronic access through the My HealtheVet Web site to data extracted from CPRS.  Selecting the My HealtheVet icon simply opens the My HealtheVet Web site. Okay let's move on.  Onto the lower button, which is a little hard to see.  It says "Pt Insur" and it is the Patient Insurance button.  Again, some patients may not have this button enabled.  But I would like you to select the patient information button. This will list the patient's third-party insurance and billing information.  So review that information here and then select the Close button. The next button to the right of the Patient Insurance button says, "Flag." Yeah, you guessed it. It's the Patients Record Flags button.  Again, this button is only enabled if the patient has Patient Record Flags.  I have already shown you these a few times so let's just skip this.  Below the Patient Record Flag button we see the letters CV December 31, 2013 on our patient.  This is a quick visual indicator that our patient is a combat veteran and the date of expiration of his or her combat status. Please select that combat vet December 31, 2013  button. 
A dialog will display showing the branch of service, the type of service discharge, and if the patient is or was part of the OEF/OIF campaigns. Again those acronyms stand for Operation Enduring Freedom and Operation Iraqi Freedom.  The expiration date is calculated to be five years after their combat end service date.  After reviewing this dialog, select the OK button. Buttons, buttons, buttons.  So many buttons, so little time.  Now, take interest to the vertically stacked buttons VistAWeb and its extremely close friend Remote Data.  Veterans may visit multiple VA Medical Centers as well as have medical data from the Department of Defense.  These buttons will allow you to review remote data on your patient.  They basically do the same thing, they query the remote sites and show you the clinical data that you ask for.  What is different is VistAWeb is a Web-based interface whereas the Remote Data button, uses the CPRS interface to display the data to you. I'll be showing you both of these shortly and you can decide which one you prefer to use.  Personally, I think the VistAWeb interface is extremely easy to use and pretty intuitive on its own, and our statistics show that most providers use VistAWeb for their remote data queries.  
Okay, so the Remote Data button, if remote data is available, it will be enabled in blue. It's a visual indicator that shows you that this patient has been seen at another VA Medical Centers or the Department of Defense centers.  Our button is blue, so I know this patient has been seen at these other medical centers, but where?  Let's simply select it right now, the blue Remote Data button, to see where our veteran has medical data. Note this patient has been seen by the Department of Defense, Upstate New York, and also our local site, which is not listed, which is in this case, the VA Medical Center located in White River Junction, Vermont.  
We will revisit this topic later in the Reports tab.  Select the Remote Data button again to make that list box disappear. Okay, another button on the informational header is the alarm clock. That clock will sound off if CPRS detects that your eyelids are getting heavy.  Humor me and select the little alarm clock next to the remote data views. Remember our discussion about clinical reminders?   This little gem shows us those available reminders again, in another view, and which reminders are due on our patient and this dialog will allow us to get more information about a particular clinical reminder.  Again, these are the same ones that show up on the Cover Sheet.  But also, there are other folders beneath there showing us which reminders are applicable, not applicable, etcetera.  Under the due folder, I'm going to right-click on the hep C risk factor screening. Now I would like you to go ahead and select Reminder Inquiry.   
This shows us the actual cohort logic for the reminder, why it was due, and what date it was used to determine if it was due. Go ahead and select the Close button. And now go ahead and close the Available Reminders dialog by selecting the X box in the upper right-hand corner. Later Neil will show you how to process these clinical reminders and satisfy them as you create your progress note encounter.  The buttons next to the little alarm clock for clinical reminders is called the Postings button.  And in our case, it's got a big red C-A-D in there, which indicates to us that our patient has crisis notes, allergies, and advance directives.  Some patients' Postings button may also contain a "W" which indicates that warning notes are also entered on this patient.  Please select that Postings button. It will then display those items to us and by selecting any of the entries, CPRS would display the details to us. By having these buttons on the informational header, we can display this data no matter which chart tab that we are using.  So, go ahead and select the Close button now in the lower portion of the Patient Postings dialog box.
Topic 5:  CPRS Chart Menus and Menu Selections
I want to bring your attention to the patient's name button. To the left of that is an icon that looks like a little blue person with a chain link that is linked. It's called the "clinical link" or CCOW icon. This icon shows you whether this patient will be automatically linked between software applications. The clinical link can be set indifferent ways. It can either be linked or not linked. If linked and we are launching another CCOW-aware clinical application, it can automatically choose the same patient for us, which is a pretty good timesaver. In this particular case, the clinical link is set. The chain link is linked. CPRS is programmed to allow a second CPRS session to be opened unlinked, which allows you to view different patients' charts without closing the one you are currently working on, which is convenient. This can be helpful when you have a quick and focused task to take care of on that second patient, but we'd advise that you close that second session of CPRS after completing that task, and continue using your original CCOW-linked session.  Please select the File menu.

And you can see that we could actually break that patient link. So please select the Break link, which is halfway down on the screen. Ah, now we have a picture of a crowd of people having a party and that clinical link is broken in half. So now the patient is not shared between software programs. If we launched another clinical application, it would not automatically choose  Patient Twenty.   It would make us choose our patient ourselves because we broke that clinical link.  Let's relink it. Let me show you how easy that is. Again, select the File menu.

Now I will hover my mouse over rejoin patient link. When I do that I have two options: to set new context or use the existing context. We're going to use the existing context.  

Patient Twenty was the existing context before we broke that link, and that's why I wanted you to use existing context again. So now that we're relinked, we can see the little blue person with the linked chain link.  And that's all I have to say about CCOW. But in summary, context is the ability of a workstation, your computer, to know which patient and what user is currently relevant. If you open up multiple CCOW applications, they can be linked to the same patient or not linked. With that, let's finish our review of the Cover Sheet by bringing your attention to the top of the CPRS GUI window where we will review the menu bar. Let's select File first. We can select a new patient, refresh patient information, rejoin or break our CCOW link, update the provider location, which is the same as selecting the patient location button, or we can review and sign our orders. A few other options also display allowing us to process our notifications, which we will go over shortly.  

Now, select the Edit menu.

The only selection that's available is Preferences. Select that. It allows us to change the font size of our GUI chart. We're not going to do that because if your eyes can stand it, CPRS works best at an 8-point font. Let's slide over to the View menu.  Select the View menu.

Here I am going to hover my mouse on the Chart Tab selection.  This would allow us to select a different Chart tab.  But note the keyboard shortcuts. Now I'm going to slide my mouse down to hover over the Information Selection. This allows us to get information about our patient, their demographics or their visits. Basically, I'll just tell you, all of these items are simply the buttons that I just went over across the patient informational header.

Let's move on. Select the Tools menu. It allows us to launch other clinical applications. Clinical coordinators can add items to the Tools menu that can assist you. For example, we have selections to launch a drug inquiry or formulary, iMedConsent, a telephone book, dental record manager, the Clinical Case Registry, VistA Imaging, and other applications.  Toward the bottom of this list, we can also launch the enhanced graphing tool here and get lab test information. The Tools, Options selection is a nice little gem that will allow you to customize your CPRS application. Now select the Help menu.    

This allows us to get more information about CPRS. And actually CPRS has a very good help system under Contents which you can review to get more information about the CPRS chart. Time to go round up some peanut M&Ms.
Topic 6:  Problems Tab
Now that we have reviewed the CPRS Cover Sheet, let's go over a different tab.  At the bottom of the CPRS chart, select the Problems tab. Welcome to the Problems tab.  The Problems tab is used to document and track a patient's problems.  It provides the clinician with a current and historical view of the patient's health care problems across all clinical subspecialties.  Our problem list in the VA uses the Lexicon utility, which permits use of natural terminology when selecting a problem and uses the ICD-9 nomenclature.  
The first thing I want to point out to you is that there's a list box on the left that shows the types of problems, active or inactive or both or removed  problems.  Initially what's displayed to us is this patient's active and inactive problems.  I know that is my view because it states so right above the grid which is actually listing the problems.  We can easily change which view that we want to have displayed to us by simply selecting what view option we wish to see.  So, under the view options select the word, Inactive.

Our view changes.  We will now only see the fracture of ankle which is an inactive problem.  We could also display the removed problems if we wanted to.  You get the point; you can change your view.  Each of the CPRS tabs will allow you to change or customize your view. Now select the view option of Active.  That's the first one in the list. Let's save this active view as our default CPRS view.  Select the View menu. And choose the selection,

Save as Default.

A confirmation dialog is displayed.  Select Yes.

Now for any patient, our CPRS Problems tab will have active problems as our default view when we navigate to the Problems tab.  Okay. For the next item, I would like to actually show you how to enter a new problem.  We are going to enter a new problem for coronary artery disease.  So, on the left-hand side, select the New Problem button. A problem list Lexicon search window will open.  Position your cursor in the enter term to search input box, and type in C-A-D.  Then select the Search button.

A few selections should display for CAD.  One with CAD as the abbreviation and the other the full name of coronary artery disease. Both entries should have the ICD-9 code 414.9.  We could select either of these, but I want you to select the second entry from the top, coronary artery disease.  

A grid-looking dialog box opens up and allows us to enter information for this.  For today, we're going to say this is an acute problem, so select the Acute button under Immediacy.

And type in the date of onset, 09/15/2009.

We could also add comments to this problem by selecting the Add Comment button.  We're not going to do that at this time.  Let's just go with what we have here.

However, I would like to mention the checkboxes to the right of this dialog box titled, Treatment Factors.  Some of these may be grayed out for your patient, for the ones that are not grayed out it's important to associate whether this problem is related to one or more of these treatment factors by checking the appropriate checkbox.  The factor with the abbreviation MST is an acronym for military sexual trauma.  Again, we have entered the new problem for coronary artery disease.   Select the OK button in the lower right-hand portion of this dialog. So now we have a problem for coronary artery disease, that is now entered in the patient's problem list.  Please note the status of the problem is an active problem but it has a little asterisk next to it. This means that it's an acute problem, and that's why it has that little asterisk next to it.  How do we inactivate a problem? That's pretty easy to do.  First thing we have to do is select a problem.  Let's select a problem in our list. 

Let's choose chronic systolic heart failure by selecting it. And now, we could select the Action menu and choose Inactivate, but there is an easier way.  You won't be able to do this in this training, but you can use your mouse to simply right-click on the chronic systolic heart failure and select Inactivate, which is pretty simple, and that's what I'm going to do.  And now the problem simply disappears, because our default view is what?  Our default view is active problems. So this inactive problem has been voted off the island of active problems.  And again, if we wanted to see both active and inactive problems, we could simply select that view from the list.  The other thing you might want to do is add a comment to it. I'd like you to do this on one of our problems. Let's annotate the acute myocardial infarction problem.  Now, select the acute myocardial infarction problem which highlights that problem.

And then if you could, you right-click on the mouse and choose annotate, which I am going to do.  And now select annotate. An annotate a problem dialog box displays.  

Using your keyboard type in "anterior lateral MI." Select the OK button. So now we have a anterior lateral MI comment added to this problem entry.  Congratulations, you are now a Problems tab Jedi knight.  Throw away your prescription pad folks, because the force will be with you as Dr. Neil Evans takes you through the ever-popular Meds tab.
Topic 7:  Meds Tab: Views
Alright well, welcome to the Meds tab, the next stop on our tab-by-tab tour through CPRS. I'm Neil Evans and while Rick runs off to fetch us some coffee and donuts, I'm going to take over your guided tour. So let's turn to the Meds tab. And we'll 

select the Meds tab itself, which is located at the bottom of your screen. The Meds tab contains a list of medications for the selected patient, as you would expect. It's divided into three panes. One for the outpatient medications at the top.

One for non-VA medications in the middle.

And one for inpatient medications at the bottom.

Now, if our patient was an inpatient, the inpatient meds section would appear at the top, the outpatient meds at the bottom. Basically the Meds tab adjusts itself automatically based on the patient's status. Let's turn our attention to the Outpatient Medications pane at the top of your screen.  In prior versions of CPRS, this list was not sortable, a regular complaint of active CPRS users. Well, that problem has been addressed.  And there are now three available views for the Medications tab that I'd like us to review. As an aside, there is still a very useful and robust sortable medication view on the Reports tab that we'll cover later.  

Select the View menu at the top of your screen to see the available sorting options here on the Meds tab.

You'll see at the bottom of this menu, the three available views. Sort by Status/Expiration Date, Sort by Status Group/Status/Location/Drug name

Sort by Drug (alphabetically)/status active/status recently expired. The default view is usually the first one when you take CPRS out of the box. However, once you've chosen a different view, CPRS will remember your preference as we see in this case. Now, if you are like me, the name of these views leave you scratching your head a bit. What do they mean? An awful lot of slashes. And who knows what all these words about status mean. Well, don't worry. We'll work through them one at a time in just a bit. First, we need to go over the data available for each medication, which will then allow us to better understand the sorting options once we get there. 

Let's choose the default view Sort by Status/Expiration Date by selecting it and then we'll take a look at the medications list in detail. Again, look at the Outpatient Medications pane at the top of your screen and we'll take a quick visual walk-through. For each medication, you can see the prescription information listed followed by a column with the expiration date, then the status, then the last filled date, and then the number of refills.

There is also an action column seen at the far left, which currently is blank throughout, which we'll discuss in a minute. Which medications are displayed here on the Medications tab is determined first by the view you choose and second by a date range parameter that controls how far back in time old medication orders are displayed. As promised, we're going to talk about the available views in a minute. And, Rick will show how to change the date range parameter later when we talk about customizing CPRS. The displayed information for each prescription is self-explanatory.  The expiration date is displayed and this is determined automatically when the prescription is written. Also the last fill date is displayed, again, self-explanatory, though I should point out that it can be a date in the future if the patient has already requested or scheduled their next mail-out refill.  

So let's now turn our attention to the status column in the Outpatient Medications pane.

Sometimes medication statuses can be confusing, so I'd like to take a minute on this. For Mr. Twenty, we can see examples of the following statuses: active, pending, active/suspended, discontinued, discontinued edit, and expired. There are other status markers that can appear in this column as well such as hold or provider hold.  Many of these status indicators are self-explanatory, but I'd like to highlight a few that sometimes lead to confusion.

A medication in active status has been delivered to the patient in-person or by mail and remains one of their active medications until the expiration date, with refills available as authorized. Pending status occurs when a medication has been ordered by a provider but has not yet been processed by Pharmacy. Next, active/suspended status, now this one is an important one to understand. This status means that the medication is still active, but somebody has taken action on the script, on the prescription.  For example, the patient may have requested a refill for their medication through My HealtheVet or by telephone and this refill request is in the queue for processing at one of the consolidated mail outpatient pharmacies run by the VA or through their local facility pharmacy. The medication is in suspended status to prevent the provider from entering a new refill order when one already exists. 
This prevents duplicate refills from being sent, which results in both cost savings for the VA and the patient, as well as improved patient safety. The hold status, which we don't see here but can appear, indicates that a medication has been put on hold by either the provider or the pharmacist and further fills of the medication can't be generated until that hold is released. And finally, let's discuss the expired status. This status is applied once a script passes its expiration date, which is usually one year from the date the script is written, assuming the provider orders a year's supply. For example, a 90-day fill with three refills. Okay, this next bit is really important. 

Patients often are still taking a medication that is in expired status in CPRS. Now, how does this happen? Well, it is not unusual for a script to expire and move into the expired status just before the patient returns for their next visit. But, the patient still has an adequate supply of the medication at home and they are still taking it.   The take home point? Expired medications should be reviewed at clinic visits or on hospital admission as part of the medication reconciliation process. Often, you'll find that at least some of the expired medications are in fact still medications that the patient is taking and the script needs to be renewed to restore it to active status. 

Let's dig a little deeper. We're going to look at the medication listed third on your list, metformin. Now, you can't double-click in this training, so I'm going to do it for you.   I'll double-click on the medication metformin to show you more information. And here we see the Outpatient Medication Details box, which gives us a significant amount of information about the medication beyond what was displayed outright on the Meds tab proper. First, we can see the actual prescription information at the top. The next section down shows the activity on this script. We note that the prescription for metformin was a new order entered by provider, VeHU Ten in August of 2009. If the pharmacist made an adjustment to the order, we'd see that listed here as well.

We see the clinic where it was written, the start date and the stop date, and the current status of the script. The stop date, otherwise known as the expiration date, as I mentioned, is usually one year from the start date if the script is written with enough refills to cover a full year's supply.  But in this case, our script was only for a 90-daysupply with zero refills, so the stop date is 90 days from the date the script was originated. 

Let's turn our attention further down and we will look at the section that tells us about this patient's fill history.  You'll notice that we can see that the prescription was filled at the window on August 24,2009. If there were further refills beyond the initial fill, we'd see them listed chronologically below the initial fill data. The next section down in our outpatient medication details section, just above the series of equal signs, shows the order checks. When the provider wrote this particular script for metformin, they were prompted that there was no serum creatinine within the last 60 days. And the provider, again, Dr. Ten VeHU, who was writing the prescription, overrode the warning at that time, and wrote the comment, "patient needs to be on these." 

So let's select Close now to exit the Outpatient Medication Details window.

Okay, now that we understand the actual medication listings better, let's go back to discussing the available views on the Meds tab as promised.  

Select the View menu.

And select the first view again, Sort by Status/Expiration Date (IMO first on Inpatient).

Note that the view that you have chosen is now displayed in the gray area just above the top of the medications pane and below the patient's name.  This particular view sorts medications first by defined status groups. Pending medications are all at the top. The next status group displayed are active, active/suspended medications  all together in one status group.  Then comes expired medications. And finally, the discontinued medications. Within each of these status groups, the meds are sorted by the expiration date in reverse chronological order.  The meds that are closer to expiration are toward the bottom of the list. You may have noticed that the title of this view includes the parenthetical notation that IMO meds are listed first on the inpatient list. For most of you, this isn't important.

And for advanced users, IMO stands for inpatient medications as outpatients, a special feature your clinical applications coordinator can help you with if it is relevant to you.  

Select the View menu again.

And now we'll look at the next available View.  Select Sort by Status Group/Status/Location/Drug name.

Again, you can see the name of the view you have chosen listed below the patient's name and above the Outpatient Medications pane. In this view, medications are first categorized by three primary status groups. Those are the active medications, pending medications, and then last, the discontinued medications. 

And within each of these groups, the meds are then sorted by their individual statuses. That is, the active medications would appear in front of the active suspended medications. And then if you look at the discontinued group, the discontinued medications, appear before the discontinued (Edit) status medications. Within each individual status, the meds are alphabetized by drug name. 

Look at the active medications where you find metformin before simvastatin before warfarin. As an aside, because of all of this sorting by various statuses, I find this to be the least helpful of the views. The most helpful being the first and the third.  Let's turn our attention to the third view.  

Select the View menu again. And choose the next available view option Sort by Drugs (alphabetically) In this view, medications are simply sorted alphabetically and only medications with an active status or those that have recently expired are shown. As you can see, discontinued medications are not shown in this view. Okay, well that wraps up the available views on the Meds tab.
Topic 8:  Meds Tab: Actions
We're still here on the Meds tab.  Let's move on to reviewing the actions we can take while here.  First, let's highlight a medication by selecting it.  Select the metformin script.

Next, select the Action menu.

Here we can see the options that are available to us while on the Medications tab.  We can enter a new medication order, change a current prescription, discontinue or cancel a medication order, place a prescription on hold, renew a medication, copy a prescription to a new order, transfer an inpatient medication order to an outpatient status or vice versa, and enter a refill request.  Let's exit the Action menu by selecting somewhere in the Outpatient Medications pane. Since you can't right-click in this training, I'm going to go ahead and right-click within the Outpatient Medications pane for you.  
As you can see, some of the options from the Action menu are available for quick access from a right-click menu.  A few items are not available from this menu.  In particular, placing a medication on hold, transferring prescription from inpatient to outpatient, or copying a prescription to a new order.  Copying a prescription to a new order can be a really useful function, especially if your site has a parameter set preventing renewal of expired medications beyond a certain period of time.  So, if you are someone who relies on the ease of the right-click shortcut menu, 

make a note to yourself right now to remember that there are other options available when needed on the View menu. 

You'll see you can also choose Details or Administration History here on the right-click menu.  Details brings up the Medication Details window we already discussed when we double-clicked on a medication listing.  Administration History brings up the MAR for the highlighted medication.  This is particularly useful for inpatient medications.  Lastly, you can enter a new medication order from this right-click menu and also from the Action menu.  Most new medication orders are entered from the Orders tab, but you do have the option here as well.  Ok, let's get busy.  

We'll stop looking and actually try one of these options.  We currently have the warfarin script highlighted.  Let's renew this order.  Select Renew.

We could now simply renew the order by selecting OK.  But in this case, we want to renew it with more refills than the current zero refills available.  To do so, first select the prescription by selecting on the order itself.  

Note that the button in the lower left-hand corner that says Change Refills/Pick Up just became active.  Select that button. And here we are able to change the number of refills to three refills instead of zero by first selecting in the box.  And then entering the number "3."

We can also change the instructions to the pharmacy for pick up by selecting the arrow at the right side of the Pick Up dropdown box.

And change the selection to "by Mail."

And then select OK.

Our order has now changed to reflect what we've just done.  Look at the bottom line of the medication order on the right where it now reads "deliver by mail" and then three refills.  Select OK.  We are prompted with an order check letting us know that there is potential drug-drug interaction between simvastatin and warfarin, and also between vitamin E and warfarin.  Select Accept Order. And voila.  The medication listing for warfarin is blue because an action has been taken upon it.  Further, if you look at the Action column on the left, there is now a notation recorded indicating that this is a pending renewal order, awaiting your signature.  Let's order a new medication.  

I'm going to right-click again in the Outpatient Medications box.  And choose New Medication.

The medication order dialog appears.  We will place an order for insulin.  At the top of this Medication Orders window, type "insulin."And you will see that the available medication list below sorts automatically for you.  At this point, the available insulin products have been brought to the top of our medication list.  For patient safety reasons, you must actively choose your desired medication.  You can use the keyboard to do this, but the mouse is easier.  Select insulin novolin N (NPH) injection in the medication list. And this brings up the Medication Order dialog.  Let's order a low dose of insulin.  Select 5 units.  

For the route, select subcutaneous.

Type "BID."

And you see that the schedule options are sorted accordingly.  Select the BID entry in the list of available schedules. 

Now, look at the Days Supply box in the lower left-hand corner. Select that box.  Then type "30" for a 30 days supply. Now let's move to the Quantity box by selecting that.  Note the VI in parentheses.  This is prompting us that the desired quantity entry is not units or milliliters of insulin, but instead vials of insulin.  So, we will order just one vial of insulin.  Type "1."Then, select the refills window.  Type "3" for three refills. Pick up at the window is already chosen and we are okay with the routine priority of this order.  So, go ahead and select Accept Order to finish things up.

An order check alerts us that this patient is already on a medication to help manage their sugars, namely metformin. Since we purposely are starting insulin to help augment their metformin therapy, we'll just acknowledge the order check by selecting Accept Order.  

Select Quit, exiting the Medication Order dialog.   And we're back on the medication sheet, where you'll find a new order for insulin NPH listed in blue.  The Action column, in the far left lets us know this is a new order, not a renewal or refill or a hold, for example.  First, let's talk about non-VA medications.   

Non-VA medications can only be entered from the Orders tab, not here on the Meds tab.  Though, they are ordered by a dialog that looks just like the one we just saw.  Sometimes you'll run across a non-VA medication that is not included in the pick list of available medications.  For example, your patient may be taking an unusual herbal preparation or something of that sort.  Sites have different ways of dealing with this.  And your clinical applications coordinator or pharmacist should be able to help you.  Non-VA medications are included in order checks and beyond that, entry of non-VA medications helps with medication reconciliation.  So take the time to enter them.  You'll be glad you did.  

We're not going to spend any extra time covering inpatient medications; they are the same as outpatient medications for the most part.  But remember the Administration History feature which brings up the CPRS equivalent of a paper MAR.  As mentioned earlier, administration history can be accessed via the right-click menu or the View menu.  And that concludes our tour of the Meds tab.  Rick is still off getting the coffee, so I guess you're stuck with me for a little longer as we move on to the Orders tab.
Topic 9:  Orders Tab: Views
It's time to move on to the Orders tab. We're nearly halfway across our tour of the tabs.  Thanks for sticking with us. The Orders tab is an important tab.  It is here that you can view existing as well as past orders for your patients.  And most importantly, this is where you will enter the vast majority of your orders. To get started, let's select the Orders tab. First, why don't we go on a tour around the tab.  In the upper left-hand corner, you can see the View Orders pane. This window is most useful when you are writing event-delayed orders, which we will cover in a few minutes.  Otherwise, it simply lets you know the view that you are currently looking at.  And you won't be able to do this; I'm going to hover over the name of the view to allow it to appear in full.  And as you can see, the View Orders pane currently reads, "Active Orders including Pending & Recent Activity - All Services." This view is the default view, amongst the available predefined views. 
This is the view you see when you take CPRS out of the box. It includes all active and pending orders, and any order that has seen recent activity, usually within the past 24 to 72 hours.  The duration of time that defines recent activity is set by a parameter at your local facility of time that defines recent activity is set by a parameter at your local facility. As you can see, the unsigned medication orders we just entered during our tour of the Meds tab are shown on this view.  And they are seen because they are considered recent activity.  And they are blue because they are unsigned.  For the most part, this is the primary view, the one that we're looking at right here, active orders including pending and recent activities, that you will use in your everyday routine.  You're usually interested in the now, what's active or pending and what has been done recently. What's going on right now.  But, there are other predefined views that might be of interest to you, particularly in certain situations. Let's take a look.  Select the View menu. 
The other predefined views are listed here.  Below the default Active Orders view, the one that we're looking at right now, you can see that there's listed, Current Orders, AutoDC/Release Event Orders, Expiring Orders, Unsigned Orders, and Recently Expired Orders.  Let's select Unsigned Orders. And look at that.  Now we see the unsigned medication orders we generated during our tour of the Meds tab.  Let's take a little bit of a closer look at what has happened. First look above the Order Sheet and also in the View Orders Pane.  In both locations, we see a written description of our current view, Unsigned Orders from All Services. The other warning that we are not looking at all active and pending orders, can be seen above the right-hand corner of the Orders box, at the very right-hand side of your screen.  There you'll see an icon with a paper with two hands covering it.  And this tells you that you are not seeing the entire order sheet.  You're a few cards short of a full deck whenever you see that icon. Okay, let's see how we can customize our view.  To do so, select the View menu. And choose Custom Order View. 
Let's say you are looking for an old medication that you know has expired.  Our patient, Mr. Twenty, tells us that he used to be on a betablocker, but you aren't sure which one.  So let's take a look at our custom order window and figure out how to find this old order for a betablocker.  In the window on the left, we need to choose the status of the order.  In this case, we know we're looking for an expired or completed medication order.  And so we will choose Completed/Expired by selecting it. And now we turn our attention to the right window, where we can now limit our search to the actual type of order that it was. In this case it was a pharmacy order, so we will select Pharmacy. And now, you can see that the search criteria that we just set now appear in bold text at the top of our Custom Order View dialog. It now reads "Completed/Expired Orders - Pharmacy," reflective of what we just chose.  Select OK to accept this view. 
And here is our custom view showing us the completed and expired pharmacy orders.  Again, a description of the view is listed in the View Orders pane and in the gray area above the order sheet.  And again our friendly icon with the two hands covering up a piece of paper in the upper right-hand corner appears, reminding us that this is a limited view.  Well, we've answered our question. Our patient, Mr. Twenty, was on metoprolol back in 2005 and again in 2008.  The initial order was placed on March 17, 2005.  And if we're interested in more detail, we could double-click on the order itself.  When we do, we get the same information that we would get on the Medications tab, looking at an order detail.  As an aside, there are better ways in CPRS to find a patient's prior medications, via the graphing or the Reports tab.  These are covered elsewhere in the training.  I chose to look up this old medication order primarily to review the general principles of finding a distant order.  In my everyday routine, I find using this view on the Reports tab to be particularly helpful in tracking down old imaging orders for studies a patient didn’t have done for some reason.  Now that we’ve looked at a custom order view, let's return to our default view, the active orders.  Go to the View menu. And choose Active Orders. Now, let's take a closer look at the actual listing of orders, typically referred to as the order sheet.  The relevant details for each order are shown in columns, including the provider who placed the order, the status of the order, the location where the order was placed, and the details of the order itself. You'll note that the orders are organized in categories. Outpatient medications are listed first, followed by non-VA meds, followed blabs, and so on.  The orders are not sortable on the Orders tab by selecting on the column headers.  This is similar to the Medications tab, that by clicking on the column headers, you can't sort.  Well that wraps up our first section on the Orders tab.  Let's move to the next section, Writing Orders.
Topic 10:  Orders Tab: Writing Orders
Welcome to the next section on the Orders tab.  We're going to start with learning how to write delayed orders.  Although all the lessons that we're going to learn while writing delayed orders are applicable, and the very same as if you are writing orders that are not delayed orders.  So if you start to say to yourself, I'm never going to write delayed orders because there's no reason for me - pay attention.  It's still relevant.  First, let's turn our attention to the Write Delayed Orders button below the View Orders pane.  And it's with this button that you can begin the process of writing event-delayed orders.  An event-delayed order is an order that is executed only after a predefined event, known as a release event.  The release event can be something like an admission, a discharge, or a transfer.  Your clinical application coordinator defines the release events at your site.  Let's take a look at how this works.  Select the Write Delayed Orders button.

Here you will see a list of events that have been set up as possible triggers for execution of a desired set of orders.  In our virtual hospital today, the only option is Admission to VA Hospital.  At your site, you might have a long list here, admit to medicine, admit to surgery, transfer to the community living center, etcetera.  Since we have only one option in our case, let's choose it. Select Admission to VA Hospital.

Select OK in the upper right-hand corner.

A dialog box appears, which allows us to copy active orders to our delayed order set.  This is quite useful, for example, when transferring the orders for patients' outpatient medications to the inpatient environment.  On admission or in anticipation of admission, you don't have to individually reenter all of the patient's active outpatient medication orders.  Let's choose two of the listed outpatient medications for inclusion with our delayed admission orders. I'm going to press and hold the Control key and then I'll select each of the medications in turn.  I'm selecting simvastatin.  And while still holding Control, choosing warfarin as well.  Now, I'm going to release the Control key.  Now choose OK.  

A dialog box appears warning me that I'm writing delayed orders for admission to the VA hospital, and that these are not orders that will be currently released. Select OK.

And now the warfarin order dialog appears, and everything is already filled in for us.  So we can simply select Accept Order. 

Select Accept Order to acknowledge the order check.

And now the medication ordering dialog for simvastatin appears.  And everything's already filled in for us.  Select Accept Order. Then select Accept Order again to acknowledge the order check. Now, we see the list of delayed orders.  Notice the View Orders pane now contains two groups.  The active orders, or the last default view that you looked at, is still listed in the first position.  But now, we see text that says "Delayed Admission to the VA Hospital." You can now toggle back and forth between these two sets of orders that are being placed by selecting either title.  Note the Event column at the far left side of the order sheet, which also designates these orders as delayed,  for admission to the VA hospital.  Since we're entering delayed orders, let's place a few more we'd like to see enacted at the time of Mr. Twenty's admission.  Let's turn our attention to the last pane on the Orders tab that we have not discussed and that's the Write Orders pane.  This is the tall skinny window on the left that's beneath the Write Delayed Orders button.  In this case, it's actually labeled as the Write Delayed Admission to VA Hospital Orders pane, but normally when we're writing non-delayed orders, the window is simply labeled "Write Orders."  

I think we should allow our patient to eat once admitted.  By the way Rick, where are those donuts you were fetching?  Hmmm.  He's not back yet.  

But while we wait and dream of food, let's select Diet Order. And here in the Diet Order window, you see some default diets listed. Before choosing a diet, look around the Diet Order dialog and you'll see that there are different tabs for tube feeding or early and late tray, precautions, etcetera.  We're going to stay right here on the Diet tab and begin to type "Diabetic" into the Available Diet Components box. Choose Diabetic 2000 Calories.

You'll see that the diet that we've selected now moves to the Selected Diet Components box.  Select Accept Order.

And there it is.  Your order has been placed on the order sheet. The diet order we just placed was a regular old order, not what is referred to as a quick order.  In the case of the diet order, we had to go into the ordering dialog for diets and fill in all the required fields one by one.  In this example, our order was quite simple as we only had to enter the type of diet.  But sometimes, there's a lot to enter to complete an order.  Now, quick orders are different. With quick orders, the order dialog has been partially or completely filled in already either by you at the personal level or at the institutional level by your clinical applications coordinator.  Quick orders help clinicians place common orders more efficiently.  While we're still writing delayed admission orders, let's take a look at a quick order.  We've just entered our diabetic diet order and we remember that we should get nutrition involved.  In fact, we do this for all our diabetic patients. We do it often, so often that our clinical applications coordinator created a quick order for us and deployed it right in the middle of the Write Orders pane on the left. 

Select the option that reads Diabetic Nutrition Consult. The Consult Order dialog launches and you can see that this quick order already has the appropriate ICD-9 code preloaded into the Provisional Diagnosis box and also has the reason for request completed for us.  We simply have to accept order to place it on the order sheet. We could add more text and edit it if we wanted to, but for the sake of time, let's choose Accept Order.

Now we'll order some labs to demonstrate another timesaver, the Quick Order menu.  Look at your Write Orders pane on the left-hand side, and you'll see an option that says Inpatient Labs Routine menu.   The ellipsis at the end of the title tells you that this option will launch a Quick Order menu.  Select Inpatient Labs Routine menu. The gray box you see is a Quick Order menu. These orders all have carriage return arrow to the left of the quick order.  This means that the quick orders on this menu have been set up to auto accept.  When you select these auto accept quick orders, they go straight to the order sheet without requiring any further confirmation.  Of course, this also means you aren't given the option to edit them before they are placed on the order sheet.  Let's select CBC.

And now you can see in the background that a CBC order has been placed on the order sheet.  Let's order a few of these lab tests all at once using what we call an order set on-the-fly.  I'm going to show you how-to do this.  

I will press and hold the Control button.  And while holding Control, select chem 7, lytes, and liver profile.  Now, when I let go of the Control button you'll see a gray box appear in the lower left-hand corner.  Your three orders will be placed in sequence onto the order sheet automatically. 

And then that gray box, the order set box, will disappear.  This is what we call an order set on-the-fly, and is really useful when you want to quickly place a series of orders from an Order Set menu.  While we are on the subject of order sets, let's see what a predefined order set looks like, as opposed to an order set on-the-fly, which we just went over.  Predefined order sets can be set up by your clinical applications coordinator.  First, select Done to exit the Inpatient Labs Routine menu.

And now choose Clinician Add Order menu. 

Look in the middle column and find Mike's order set.  Select this once. You'll see the order set window appear in a lower left corner. The first order in this set is for an upper GI with KUB.  This radiology order can't be completed unless we enter a reason for study.  Type "dysphagia" in the Reason for Study box, D-Y-S-P-H-A-G-I-A.  The desired date field is also required.  Select the Date Desired box and then enter the word "today."

Now select Accept Order.

The order you just entered for an upper GI with KUB was placed on the order sheet and you are automatically moved to the next order in the order set, small bowel multiple films.  Let's say we've decided we really don't want this study done.  We can simply select Quit and this item from the order set will not be entered.  

And now the next order in the order set appears. It's an NPO diet order. We now decide that we really don't want to process Mike's order set and we're not interested in going through the rest of it. This sometimes happens when you inadvertently get started on a long order set,  such as an admissions order set, and discover that it isn't really what you thought it was. Select Stop Order Set, which you'll find in the lower left-hand corner of the order set box to abort this order set. A prompt appears asking if you really want to interrupt your order set. Select Yes and you're done. And now select Done to exit the Clinician Add Order menu. Let's sign our delayed event orders.  

I'm going to select and drag to highlight all of the blue orders.  And now all of the orders that I want to sign have been selected.  There are a few options at your disposal when you want to sign orders. You can right-click and choose sign or go to the File menu and choose Review/Sign Changes or go to the Action menu and choose Sign Selected. Let's go to the Action menu. 

And choose the bottom option, Sign Selected.

An order check box appears.  Select Continue.

And now the Signed Orders dialog has appeared.  Enter your electronic signature code, where prompted.  And that is vehu00, V-E-H-U-0-0.Select OK.

And now you see that the blue orders have turned black; they have officially been signed and transmitted.  These orders will be automatically released based on the trigger event, admission to the VA hospital. If you've entered your delayed release orders and later decide you'd like to manually release them, that can be done as well. I should give you an example of how this might occur. Let's say the trigger event was admission to the medical service, but then plans changed and the patient was actually admitted to the surgery service instead. Well the trigger event of admission to Medicine didn't actually occur, so the orders wouldn't have released. But you still might want some of those orders that you had spent time entering as delayed release orders to be active while the patient is on the surgery service. Let's show how we can manually release some of the  orders we just wrote. Highlight the order, diabetes nutrition consult. Select the Action menu.

And choose Release Delayed Orders.

Select OK. 

And now the diabetes nutrition order has been released in the current setting, which in this case is the outpatient setting.  I should also mention auto DC orders, which are related to delayed orders.  At some sites, CPRS is set up to automatically discontinue orders on transfer from one level of care to another, for example from the ICU to the floor.  When the transfer occurs, the orders are discontinued and marked as auto DC orders associated with the release event that just occurred.  These orders can still be found by selecting the View menu and choosing the AutoDC/Release Event Orders view.  This allows you to find orders that have been automatically discontinued and also orders that have been released upon a certain trigger event.  Now here's a timesaving hint:  

If a whole bunch of orders you liked have been auto DC'd, and you'd like to restore them quickly, consider finding them with the view I just mentioned, highlighting the ones you want to restore, and then choosing Copy to New Order on the Action menu.  Well that ends our review of writing orders on the Orders tab and in the next section we're going to cover personal quick orders and more.   
Topic 11:  Orders Tab: Personal Quick Orders and More
Okay, let's first switch away from our delayed admission orders back to active orders.  Look in the View Orders pane in the upper left-hand corner and select Active Orders.  

Now, let's order a medication and while doing so, also learn how to create personal quick orders.

Select Outpatient Medications in the Write Orders pane on the left. Since we're going to create a personal quick order, I've chosen medication that I often order in my primary care clinic, lisinopril, an ACE inhibitor for hypertension.  Start typing "lisinopril" in the top box of the Medication Orders dialog.  L-I-S-I. And you'll see that the list of medications in the formulary has sorted and brought the relevant medications to the top.  Lisinopril is now at the very top of the list.  Select Lisinopril.  This launches the medication order dialog for lisinopril. Select 10 mg as your dose strength. 

The route is already defined for you as by mouth.  In the schedule box, type Q-D-A-Y.  

And choose the schedule, QDAY.

I personally like to put in the comment box something to let the patient know why they're taking this medication. 

Place your cursor in the comment box.  And type, "For hypertension."Now, place your cursor in the days supply box.  

Type "90," 9-0. 

You'll note that when I change the days supply to 90, the quantity of tablets automatically changed from 30, which had been shown prior, to 90.  CPRS automatically calculates the appropriate number of tabs for the schedule and days supply chosen.  And now, move to the refills box by selecting it. And here, we can enter a number directly or use the up and down arrows.  Select the up arrow three times to generate three refills. We'll leave the pick up as is, which is window.  And so we've now entered our order.  Now we just spent a reasonable amount of time entering this information, and it's a medication as we covered, that, we might order frequently.  I'd rather not enter, type in, "for hypertension" every single time I enter a new lisinopril script.  So, it would be nice if I could save this order that I've just prepared for use again in the future.  Let's do so by setting it up as a personal quick order.  Don't select Accept yet to accept the order.  

Instead, first select the Options menu in the main CPRS window. And choose Save as Quick Order.

Now you'll see the Add Quick Order dialog box. First we need to enter a name for our quick order. 

Let's name it lisinopril 10 mg.

Select OK to accept this as a quick order.

And now select Accept Order to accept the order for lisinopril that we just entered.

Select Quit to exit the Medication Order dialog.

And now we'll again select Outpatient Medications again to see where our quick order appears. 

Notice now, that in the second box in the Medication Orders dialog, we see our quick order for lisinopril 10 mg.  It will always appear herein the future unless we delete it through the Options menu and choose Edit Common List.  Let's see how this quick order works. Let's select directly on the text of the quick order that we just entered, lisinopril 10 mg.

And here you'll see our quick order automatically appears, with the text entered as defined before.  Since we've already placed a lisinopril order, let's select Quit so we don't enter a duplicate now.

Select No when prompted.  Again, we've already placed our lisinopril order. But I should mention one thing personal quick orders can be set up for labs, medications, and consults.  I've shown you how to set up personal quick orders for a medication.  The process is the  very same for consults and labs.  Though, I should mention if a consult at your site contains templated data involving patient-specific information, that consult cannot be set up as a personal quick order.  Finally, let's directly enter a physical therapy consult request that we'll come back to when we get to the Consults tab.  

Choose Consult in the Write Orders pane.

Enter "Physical Therapy."

Once physical therapy is highlighted, we can move to the right, and change the urgency of this consult by 

selecting the arrow on the right side of the Urgency box. Choose Within 1 Month.

Place your cursor in the Reason for Request box, and enter a reason for request. 

We'll type "Knee pain."

And choose Accept Order.

We don't want to enter any further consults, 

so we'll choose Quit.

Okay, let's sign whatever orders we have left to sign. Go to the File menu.

And choose Review/Sign Changes.

Our unsigned orders appear.  Note that we are being prompted to respond to two questions, SC and CV.  Service-connected status and combat vet status.  This veteran's combat vet status has not yet expired, so the CV box is automatically checked for you.  As an ordering provider, you'll need to determine if the medications you are ordering are service connected.  Look in the upper left-hand corner.  This veteran is 40 percent service connected for tinnitus and a knee condition.  So, these medication orders are not service connected.

Select the SC box once.

And you'll note that all of the boxes in that column have been unchecked.  Select SC again.

And they're all checked.  That's not what we want. 

So select SC again. 

And they're back to being unchecked, just what we want.  These medications are not for service-connected conditions.  Go to the Electronic Signature Code box in the lower left corner and enter your signature code, which is vehu00, V-E-H-U-0-0.Select Sign.

We're prompted for entering a justification for overriding the critical order checks and we must enter text in this box. 

Enter "discussed with pharmacy."  Select Continue.

And our orders are signed.  As we take our final look at the Orders tab, let's say you notice that your resident ordered a chest X-ray on a patient but she is about to go on service at the university hospital and won't be able to follow up the result.  Highlight the chest X-ray order that is listed by selecting it. Then go to the Action menu.

And choose Alert when Results.

You can then change the provider to whom the alert will go for this result, the notification of the result will be directed to the provider you choose.  Note that once this alert has been assigned to someone through this menu option, it can't be changed after that.   Let's change the alert recipient to us Vehu,Zero Zero.  Select in the alert recipient box and type "Vehu,Zero Zero."We find Vehu,Zero Zero, that's us. 

Select OK.

The chest X-ray report, once available will now be sent to us as a notification.  There's one more thing I'd like to show you on the Orders tab.  And that is how to flag an order.  An order can be flagged for attention.  For example, a nurse might flag an order asking for clarification or to bring something to your attention.  Let's go ahead and flag an order and then we'll process it later, when we review the notifications section.  

Select the culture and susceptibility, sputum order. Select the Action menu.

Choose Flag.

You can choose a default reason for flagging the order, or you can enter your own text.  We'll pretend the lab tech is flagging this for us. Let's type, "No sputum produced."

And then, we need to choose to whom the alert that this order has been flagged should be sent.  Let's choose ourselves.  

Type "Vehu, Zero Zero" in the Alert recipient box.  Select OK. 

And the order has been successfully flagged.  Note how it is marked in red.  As I mentioned, we'll look at the notification generated by this order flag later.  As we bring our review of the Orders tab to a close, I should mention that the Orders tab is not the only place where orders can be generated, though it is definitely where the vast majority of them are entered.  Other places where orders can be generated are medications can be ordered on the Medications tab, consults can be ordered through the Consults tab. And finally, orders can be placed via reminders or reminder dialog templates, which are all found on the Notes tab.  Well, Rick is back with the coffee and donuts finally and he's placed his order.  It's time for a break.  I'll see you in a few minutes on the Notes tab.
Topic 12:  Notes Tab: Accessing Data
Okay, we're moving on to the Notes tab now. Now this is a place where you're certain to spend a lot of time if you use CPRS on a daily basis. It's here that you can view patient progress notes. And it's also here that you can write and edit notes, cosign notes, enter encounter and billing data, and even more. Further, the Notes tab is where reminders are processed. And finally, it is here that you access templates in the template editor, features of CPRS designed to help make your documentation less burdensome. 

In summary, there's a lot going on here on the Notes tab. With so much to cover on the Notes tab, we're going to break things up into three sections. This section will be about accessing data on the Notes tab, finding exactly what you want in the midst of all those notes. In the last two sections will cover entering data on the Notes tab.  We'll cover writing notes, processing reminders, using templates, and more. Let's dive right in and take a brief tour of the Notes tab. At first glance, it looks quite simple. 

On the left is a list of notes.  We refer to this as the document list pane. 

And on the right is the viewing window, or editing window, for notes. But there's more.  

Let's take a look. Select the heading, All Signed Notes at the very top of the document list pane.

If you select a heading in the document list pane, you will then seethe three-window view instead of a two-window view. The overall document list is still displayed on the left, however the window on the right has split in two. 

The upper half is a sortable list of the notes included in your selected heading on the left. 

The bottom half of the window on the right shows the text of the note selected in the top window. This ability to easily sort notes on the Notes tab can be quite useful. 

Remember though, you need to select a heading in the document list pane on the left to reach this view. Now, let's turn our attention back to the document list pane. That's the pane on the left-hand side of your screen. I'd like to talk now about custom views on the Notes tab. Remember this; you only see the data you ask for in CPRS. Be aware of your chosen view, in particular, of your default view. To demonstrate this, the default setting in our virtual hospital account today is the last three signed notes. This means that whenever you enter a new chart, only the last three signed notes are shown.  
But of course, there could be more than just three notes in the chart. And some of those notes might contain some data that you want to see. As an aside, the default at most medical centers is to show the last 100 signed notes. You can imagine a scenario where the 110th note is what you were looking for. Our practice accounts here don't have 100 notes, so we set the default at three for instructional purposes. Look at the text just above the document list pane and you'll see that it says, "last 3 Signed Notes." You'll always find a description of your chosen view there. So how can we see all the signed notes? Let's go to the View menu.

And we'll choose Signed Notes All.

Now, you can see that all the signed notes have appeared and the heading above the notes selection pane has changed to reflect that you're viewing all signed notes. 

Now I'm going to right-click in the document selection pane, the one on the left. 

And you'll now see that the view options are also available through the right-click menu. Let's choose Signed Notes by Author. Choose Vehu,Twenty.

Now select OK.

You can also look at signed notes by date, uncosigned notes, and unsigned notes. There's no need for us to select through each of them. Instead, let's go back to the view, Signed Notes (All). Go to the View menu.

And choose Signed Notes (All).

Now, let's talk about custom views. Go to the View menu.  And choose Custom View.  

Setting up a custom view you like can be really useful. The longer a patient has been receiving care at your VA, the longer the list of notes and the more time you can spend trying to find the morsel of information that you're interested in. Being able to leverage custom views to your advantage can lead to big time savings. Let's take a look at a few examples.  

At the top right of the Custom View dialog box, you can stipulate the number of notes to view. If this box is left blank, all applicable notes will be retrieved. There is, of course, a trade-off here. The more notes you ask for, the longer the information may take to load. Today, we'll leave this box blank for now to bring back all relevant notes.  

Let's turn our attention to the bottom half of this dialog box where it says Note Tree view. Here you will find the ability to group notes, which is a very useful function. Let's leave our notes in reverse chronological order. There's no time like the present, so we'll keep that at the top of our list.  

And we'll choose to group our notes by location. Select the arrow at the right side of the Group By box.  

Notes can be organized by each of the listed criteria, visit date, title, author, or location. Let's group by location.  Select Location.

And now select OK.

As you can see, the notes are now organized into file cabinets by their location. If you select any of the file cabinets, you will see the three-screen sortable view appear again. Let's select the file cabinet for Audiology.

There are two notes that were generated in Audiology clinic. You can see them listed in the top pane on the right and the text of the selected note in the bottom pane on the right. The notes in the top pane are sortable by selecting any of the column headers.  

Let's select again the View menu.

And choose Custom View.

So, we've now seen how to group notes into file cabinets by location. Again, this can also be done for visit date, note title, or by author. Let's look at another custom view. First, we'll select Clear Sort/Group/Search button, in the lower left-hand corner of the Custom View dialog box, to clear our current view, which is grouping by location.  

Now, look at the very bottom of the custom view dialog. And find the box that reads, "Where either of:" and choose Title. Enter into the Contains text box the word, "medicine."  Select OK.

Now I personally find this view to be very helpful. Any note title that contains your keyword is bolded, allowing those notes to stand out amongst the others. When I see patients in primary care clinic, I make sure the primary care notes are all bold by using this view.  This allows me to find my notes easily and also allows me to get a quick sense for the interim events since my last visit with the patient by looking at all the notes sandwiched between my new primary care note probably in progress and the previous bolded primary care note.  If this were my clinic, I'd want this particular view to be my default view.  Now pay attention here. This is important.  

Once you've discovered your preferred custom view, you need to set it as your default view or the view will just switch back to whatever your current default is when you go to your next patient's chart.  First, let's limit this view because you never want to set a default view to pull back all signed notes or your charts might take a while to load.  Select the View menu.

Choose Custom View.

And enter "100" in the Max Number to Return box in the upper right-hand corner.

We'll leave our custom settings at the bottom of this window unchanged because we otherwise like this view. And select OK. And now to set this as our new default view, select the View menu. And choose Save as Default View.

And then select Yes to replace your current default view. Now, let's look at the option of finding a note or notes based on searching for selected text. Choose the View menu.

And choose Search for Text. 

Type "health" as your search string. And select OK. You'll note that two notes are found. Both these notes contain the word "health" somewhere within them. Okay, now let's return to what we've set as our default view. Go to the View menu. Select Return to Default View.

And we're back at our default view. One last thing about the document list pane. It is helpful to understand the icons that are used on the list. 

Let's go to the View menu.

And choose Icon Legend.

And here you see the icons that are used on the Notes tab.  In particular, I'd like to point out the interdisciplinary note, represented by a file folder. An interdisciplinary note can be set up by your clinical applications coordinator, and allows all notes related to a certain episode of care, for example an outpatient procedure, to be collated in one place. The other icon I'd like to point out is the tiny picture of a landscape with the sun on the horizon. When this icon appears next to a note, it means there is an image associated with that note. 

the image can be found in VistA Imaging. Select OK. And that concludes our discussion of how to access data on the Notes tab, including the use of custom views. Now, let's move on to Notes tab part 2, where we'll learn to write a note.
Topic 13:  Notes Tab: Writing Notes
Welcome to part 2 of our tour of the Notes tab.  We're now going to turn our attention to how to write a note on the Notes tab. In the lower left-hand corner of the Notes tab, you will see a button entitled "New Note."  Select this button.

The Progress Note selection dialog appears. Let's look around. Above the dividing line, you can see your preferred note titles, in our case the general medicine note. You get to choose the preferred note titles shown here. And Rick will show you how to do that later. We'll add some more preferred note titles at that time.  Below the dividing line is an alphabetical list of all available note titles.  In this window, you can also specify the date and time of the note.  The current date and time is the default. If you choose to backdate your note, the time of entry is still recorded as well.  Finally, if you are a resident or student or someone whose note requires cosignature, you would see another box at the very bottom of this window allowing you to select your intended cosigner. 

Let's press the down arrow once to select the preferred note title, general medicine note. 

Select OK to start this note.

A pop-up box appears asking if you are writing this note to answer one of the patient's unresolved consult requests.  Consult requests can only be answered using specific consult note titles and this is not one of those.  We'll talk more about that in a bit.  Choose Yes to use this title and continue.

Select OK again.

Well, here we are. We're writing a note. It's a blank note. This note title does not have a default template associated with it.  And thus, no text was brought into the note. It's just blank.  

Let's start simply by typing "Chief complaint: Too many donuts." You could just keep typing as long as you wanted. But let's consider how a template might help us and save us from typing the same things over and over again. On the left side of your screen, in the lower left-hand corner, you'll find the templates drawer. Select the drawer labeled, "Templates." 

You should see a file cabinet that is entitled, "Shared Templates."  Open this file cabinet by selecting the plus sign. Here we see the shared templates available at our virtual hospital. These templates are available to everyone.  If you write your own templates, or import a shared template for your regular personal use, those templates would appear in a separate file cabinet called "My Templates "just below "Shared Templates."  Open the folder called CPRS Tab by Tab templates by selecting the plus sign next to it.

And look for the template called PCC Note. The icon representing this template looks like a sheet of paper. This means it represents a simple text template, or what is sometimes called a boilerplate  template. As you will see, these text templates can still include patient-specific data, such as lab results and the like. But they do not require you to interact with them before they are placed into the note. I'm going to double-click on the template, PCC Note. And voila! The template text appears.  Half our note is done. 
Note that the patient's problem list has been brought into the note. And as we scroll down, you'll see that their allergies have been brought into the note as well as their list of outpatient medications. Furthermore, we see vital signs data and a summary of their most recent lab results. Now we should add an exam to our note. I'm going to use the scroll bar to move to the section in our note that says, "Exam."  Find the template titled, "Normal Exam."I'm going to right-click the template icon in the templates drawer. And choose Preview/Print Template.

This allows us to see what would be entered into our note. And it's simply a text of a normal exam. Select Close to exit out of this preview.

Let's suppose we just decided we don't want to enter this particular exam, but would rather use a different exam template. Find the template simply called, "Exam."  The icon for this template is different. It looks like a gray checklist in a file folder. This tells us that it is a dialog template. Dialog templates allow you to pick and choose what parts of the template you want to include

in your note. It can be quite simple as this one is, or can be lengthy and complex.

I've already shown that you can double-click on a template to enter it into your note. You can also drag them into your note if you prefer. I'm going to drag our exam template into our note and move it until the cursor appears where we want the note text to appear, beneath the word pain.  Then I'll let go of the mouse button to deploy the template.

The gray template dialog appears and we can now choose which elements of the exam we want to include in our note. Note that one of the buttons at the bottom says "All," and selecting this chooses all available options in the template for entry into the note. Let's do this.  Select the All button.

Checks appeared next to each of the items that will be entered into our note.  Select OK to actually enter the text at the location of our cursor.

And the text of our exam has now been entered into our note.  Writing your own templates isn't hard, particularly text or boilerplate templates. You might want to seek out some of the more comprehensive Web-based training modules available from prior VHA eHealth University conferences.

Now let's talk about processing a clinical reminder. Processing reminders can only be done on the Notes tab while a note is actively being edited. 

I'm going to scroll down in the note until you find the section entitled, "Reminders" and select beneath the word Reminders to put the cursor there.

Next, let's select the Reminders drawer at the lower left-hand corner of your screen.

The general concept of what a clinical reminder is was discussed by Rick during his review of the Cover Sheet. Again, it is here on the Notes tab that we actually process the reminders.  When you process a reminder, a few different things can happen, depending on how the reminder was created.  Text can be entered into your note. Information in the form of something called a health factor can be written into the VistA database. And these health factors help track what has been done, and orders can be generated. Let's take a look at a simple reminder called the hepatitis C risk factor screen.

I'm going to double-click on hepatitis C risk factor screen. For the purposes of this demonstration, let's select the first box next to risk factors for hepatitis (positive screen).

Notice that in the second window of our reminder resolution screen, we now see text that says "Hepatitis C risk Factor Screening: The patient has identified that they have risk factors for hepatitis C."This is the text that will be entered into our note. Look in the bottom window of this reminder resolution screen where you'll find a health factor, called hepatitis C risk factor positive.  This health factor will

be placed in the VistA database. It could then be used, for example, to trigger another reminder, one prompting testing or counseling for hepatitis C.

Select Finish and we're done completing the reminder.  The text was entered into our note, wherever our cursor was when we started processing the reminder. Some clinical reminders are written at a national level and others locally. Clinical reminders can be shared between facilities using a VistA program called Reminder Exchange. Okay, let's pretend we've now finished meeting with our patient, Mr. Twenty, but we don't have time to finish entering our note right now, because the administration just arrived with some ice cream to celebrate your selection as employee of the month.  We want to save our note without signature, so we can come back and finish it later, fueled by some Neapolitan goodness. I'm going to right-click within the body of the note 

and I want you to choose Save without Signature.

And the note is now saved, but unsigned. Look at the note list on the left and you can see how it is listed as an unsigned note, above the signed notes. Others who enter Mr. Twenty's chart will not be able to view your unsigned note unless you are a student or resident, in which case the attending you designated for cosignature will be able see it.

Off to our ice cream break. And when we get back, in the next section, we'll actually properly finish this note, signing it, and then completing the encounter.
Topic 14:  Notes Tab: Encounters and Consult Resolution
Ok, we're back from our ice cream break.  Now if you skipped the last section of this training and missed the ice cream, I'd encourage you to go back and do the prior section where we left our note saved, but not signed.  Now, it's time to finish the note.  But before doing so, we need to make one last minute addition.  

Select the body of the unsigned note. I'm going to right-click and choose Edit Progress Note.  And now we'll finish up our note.  Next to return to clinic, type "3 months."

Ok, so now we are completely finished with our note and it is time to sign it.  I'm going to right-click within the body of the note again to bring up the right-click menu.  Now, I'll point out that about halfway down the right-click menu, you'll see the option to check the spelling in your note, which you could do at this point in time if you wanted. But instead, we're just going to go right ahead and sign the note now. Choose Sign Note Now.

As you can see, we've just been asked if we want to complete the encounter. Let's select OK to bring up the encounter form.  Now I'd like to talk briefly about the PCE package. PCE stands for patient care encounters. This is where you enter what is effectively billing data.  The encounter drawer can be found in the lower left-hand corner of your screen.  So to complete encounters, you can either respond to the pop-up that occurs when you're signing your note, or access the encounter drawer in the lower left-hand side of your screen.  Let's complete the fields that are absolutely required in order to close an outpatient encounter.  Before we start, I should mention one thing. 

If you are a medical student, you should NOT include your name on any encounters.  Encounters with medical student names associated with them will not transmit properly.  

Encounter forms are organized by tabs.  We're currently looking at the first tab, the Visit Type tab. On this tab, let's work from left to right, top to bottom.  First, we must choose the type of visit.  Select Established.

Next, let's assign the E&M code, as found in the next box to the right, entitled Section Name.  We'll assume we met the documentation requirements for a detailed 99213 visit.  Select the box next to Detailed 99213.

The modifiers for this detailed exam found in the next box to the right are optional.  

Now, let's move down on this tab to the middle third of the visit   type tab. The box on the left shows the patient's service connection and a list of the patient's rated disabilities.  This information is simply displayed to assist you in answering the questions in the boxes on the right.  In this box, we are required to answer yes or no for any of the items that are not grayed out. So in this case, we must answer whether this visit was related to the patient's service-connected conditions and also must answer whether this is a combat vet related visit.  A combat vet question is already answered for us, as this patient's combat vet status is not yet expired.  

So, we need to answer the question about service connection.  Let's select no, since we didn't deal with Mr. Twenty's knee condition or tinnitus during this visit.

And now, we'll look at the bottom third of this tab.  On the left is a list of all providers at your facility.  Your name should automatically have been chosen and entered into the box on the right as a participating provider in this encounter.  If you are the attending for this encounter, you need to designate yourself as primary.  Select on our provider name at the right, Vehu,00.  And you'll see that the primary box becomes active.  Select the Primary button. 

And note how your name is now designated as the Primary provider.  Okay, we're not quite done with this encounter yet.  You're required also to complete the second tab on the encounter form, entitled Diagnoses.  Select the Diagnoses tab.


In the upper left in this tab, you'll find a box called Diagnoses Section.  The first item on this list will always read Problem List Items and will be selected by default.  The list of diagnoses included on your patient's problem list appears in the box on the right.  Since you are usually seeing a patient for a known problem, this makes it easy to find diagnoses for inclusion in your encounter. Let's select the box next to Diabetes Mellitus to include that as a diagnosis for this patient encounter.

Note how the diagnosis now appears in the bottom box as an official encounter diagnosis.  Further, it is marked as the primary diagnosis as it's the first you have entered.  Encounters must have a primary diagnosis in order to be effectively closed.  Let's enter a secondary diagnosis.  Something new we found today.   Remember Mr. Twenty's chief complaint?  Well, we've discovered that his excess donut consumption is leading to some esophageal reflux.  Let's find the diagnosis, esophageal reflux.  This time we'll use one of the customized pick lists set up on this particular encounter form.  

Select Gastroenterology in the diagnoses section on the upper left. And a list of preselected common GI diagnoses appears.  Select the box next to Esophageal Reflux.  

Note that the esophageal reflux diagnosis now appears as a secondary diagnosis in the box below.  Now, esophageal reflux wasn't included on Mr. Twenty's problem list, but we'd like to add it.  Here's a quick shortcut to allow you to add the problem without going to the Problem List tab.  As you can see, esophageal reflux is already highlighted in the bottom box.  Look to the right and select the box next to Add to Problem list.

Note how the word "Add" appeared in the Add to PL column on the far left. When you close this encounter form, the diagnosis will automatically be placed on the problem list.  Finally, let's look at how to find a diagnosis that is not listed on any of the quick pick lists.  Select the box that says "Other diagnosis."

Enter "back pain" in the search box.  Select the Search button. And we'll select the top result, Low Back Pain.

And select OK.

And you'll see that low back pain has now been entered as another secondary diagnosis.  We've entered everything we need to enter for this encounter for it to officially close. So let's move on. Select OK to finalize the encounter form.

And now that we are done entering the encounter, we can enter our electronic signature to finalize the note.  

Enter your signature code, V-E-H-U-0-0. VEHU00.Select OK.

And your note is signed. Also, look at the window that is now beneath your note, and you'll see the completed encounter data displaying there. Finally, let's demonstrate the Identify Additional Signer functionality, which is something used at most VA sites as a communication tool between providers.  When an additional signer is designated, an alert is sent to that provider.  When they view the note, they have the option to sign, acknowledging that they have received the note.  This is not the same as a cosignature and does not imply that the additional signer was directly involved in the care provided at the visit the note describes.  Again, at most sites, this is a way providers communicate with one another in CPRS. Let's see how it works.  I'm going to right-click within the addendum that you just wrote and please choose Identify Additional Signer.

Let's choose the provider at the very top of our list as an additional signer, Access,New.

And select OK.

I'm going to scroll to the bottom of our note.

Now at the bottom of the note, you'll see where it says, Receipt Acknowledged By.  Dr. Access will receive an alert directing her to this note and when she's read it, she can sign the note.  And we're coming towards the end of our tour of the Notes tab, I want to go over one last important function that's available here. Let's talk about how to use a Consult note to complete a pending consult.  As I mentioned before, there are specific consult notes in CPRS that, when linked to a pending consult, will complete the consult. And depending on the ordering provider's notification settings, the consult note will also be sent to that provider as a notification.  Closing consults properly is an important element of good patient care, and has the added benefit of avoiding lots of headaches later when dealing with unresolved consults. For the sake of this example, let's put our cardiology hats on. We're in cardiology clinic and are going to evaluate our patient, Mr. Twenty. Let's start our note. Select the New Note button in the lower left-hand side of your screen.  

Type "Consult" to find the consult note titles.

Note that the first consult title on our list is the cardiology consult note. Select the cardiology consult note to activate this choice.

Note the text that appeared toward the bottom of our note selection dialog window.  It states, "This progress note title must be associated with a consult request."  And CPRS kindly displays the list of consults that are awaiting resolution. 

Let's select cardiology consult.

Note that when we do this, the Show Details button becomes active.  Let's select Show Details.

And the detailed view of the consult appears, including the reason for request, entering provider, scheduling information, and so on.  This is definitely a consult we want to answer, so let's select Close to exit the consult detail view.

At this point, both our desired note title and the associated consult are chosen, so we can proceed and start our note.  

Select OK.

Okay. Let's write our consult note.  Brief and to the point.  Type "Cath recommended."

Select the Action menu. 

And choose Sign Note Now.

Enter your electronic signature code, V-E-H-U-0-0.Select OK.

And that's it.  We're done.  The consult has been completed.  More on this in a few minutes when Rick gets back into the driver seat to lead our tour through the Consults tab.  Until then, I should note that we are now finished with the Notes tab.
Topic 15:  Consult Tab
Okay, for our next section, we would like to do a tour of the Consults tab. So, along the bottom of the CPRS chart, select Consults. Here we are. Consults are requested from one clinical specialty to another and the Consults tab lends itself well for subspecialty to consultant communication. But the power of CPRS also allows consults to be ordered from one VA hospital to another VA hospital via an entity called interfacility consults. Or if you like acronyms, IFCs. To give you an example, I work in a hospital in Vermont which does not perform cardiac catheterizations. We send our patients down to the Boston Massachusetts Health Care System to have that test performed. Well, we can place a consult directly from Vermont that will print out and alert cardiology service in Boston that we would like that procedure performed.  And when they perform that service, the results are automatically available in Vermont as well as any consult update actions that Boston may have taken on that consult are available to us.  

So you can see that Patient Twenty has a list of consults for physical therapy, echo, orthopedic surgery, cardiology, hematology, and others. One thing I'd like to note is, next to the service that the consult was sent to is the status of the consult; it's in parentheses. And consults can be in different statuses along the way. They could either be in a pending status, a complete status, scheduled, discontinued, cancelled or simply active.  The consult status gets changed and updated by the receiving service as they take specific actions on that consult. You can see that the audiology consult from April 1, 2004 is in a complete status.  

Please select the audiology outpatient consult.

When you do that, you can see the related document, a progress note titled Audiology - Hearing Note is listed in the lower left-hand portion of the CPRS display. And the actual consult is listed in the Consult Service pane to the right as well. And also the Audiology - Hearing note result is listed there as well too. Now, you can't use the scroll bar in this tutorial, so let me show you.  As I scroll down, you can see all of the information about this consult, when it was released as an order, when somebody received it, when it was completed and updated by the actual title of the consult note that completed the audiology-hearing consult. 
Now with that said, the nice thing about the Consults tab in CPRS is that when the consultant completes a consult note, it can send a consult result alert directly to the ordering provider via their notifications list. So as you can see, this is pretty powerful.  Well, as Neil explained on some of the other tabs, you have a View menu here. You can change what's being viewed to you. If you ever get to a point where you can't recall what those little icons represent next to the consult, you can get an icon legend. For example, what's up with that little icon next to the hematology consult? It looks like a notepad with an "I" inside of it. And what's that weird looking icon next to the echo cardiology? Let's find out. Select the View menu. Now select the Icon Legend.

So this shows us the icons that are associated with our consults. We have selected a subgrouping of file cabinets.  We have the consult request, which looks like a sheet of paper. We also have a caduceus, which represents a procedure request, that would be our echo cardiology. We also have listed as an icon, something that I'd like to bring your attention to, that is that piece of paper that has an "I" inside of it. This is an interfacility consult request. Again that's our hematology consult. This was a consult request that was sent to another VA for consultation.  

So enough on the icon legend. Select the OK button, please. Anyways, one of the things that may not be obvious is how to get the results of an interfacility consult. If our IFC consult, the hematology consult which was performed at the Boston VA Medical Center, had a status of complete, to see those results from Boston we need to kind of ask to see the results with the software. The way to do that is to select the consult.  So please do that for me. Select the August 24, 2009 hematology interfacility consult.  Then select the Action menu. 

And then select Consult Tracking.

And then choose Display Results. Now I apologize, this is a test account. This IFC does not have a remote consult from Boston yet. But I wanted you to know that this is the way to get the results for a completed interfacility type of consult.   You have to actually ask for the results from the Action menu, because CPRS actually has to do a direct query to that VA that completed the consult to get the results for you. It is not that obvious that you have to take this action to see those results. So I wanted to show you and mention it to you. Okay, the next thing I would like to show you on the Consults tab are some actions that you can take on a consult. First, let's add a comment to a consult.  

Select the physical therapy consult.

Select the Action menu.

Now select Consults Tracking.

And then select Add a Comment.

Let's say the patient has told you, as the primary care physician, that he only would like this physical therapy appointment scheduled for Mondays. Let's put a comment in there to reflect that, so that the fifth physical therapist scheduling person knows about that.  Please type in the comments area there, "only Monday appointments please."  We could actually send an alert to somebody on this, as you can see by the Send an Alert checkbox. We don't need to send an additional alert in this example. So let's just select the OK button. And you'll see that an action has been added to the detailed view for this consult. We've added a comment, and it lists the comment that we added.  

And just one more thing. Sometimes a consulted to service may deny or cancel your request for consultation based on a whole host of reasons that, frankly, I don't want to get into.  But even if a service did deny the consult, you have another chance to resubmit it. Bring your attention to and please select the diabetic retinopathy surveillance consult that has an X status next to it.  The X is a cancelled status. Looks like from reading the comments, the patient did not want the test. Perhaps you called him now and made a good case for the eye exam. So now all is well and you want to resubmit the consult. Easy to do, very easy.  

Select the Action menu.

Select Consults Tracking again.

But this time, select Edit/Resubmit.

When we do that, an Edit/Resubmit dialog opens and allows you to enter new comments. We don't need to do this, I just wanted to show you how to resubmit a cancelled consult.  

So select the Cancel button to exit this dialog.

Finally, a consulting service could discontinue your consult request and that is 

a dead-end street. The door is shut when a consult is DC'd.  You'll need to order a new one if that is indicated. As Dr. Evans has mentioned, the Orders tab is not the only place you can place orders. We could actually place a new consult order from this tab or a new procedure order. We are not going to do that, but I would like to point out that you can on the left-hand side of this screen, right in the middle area, there are buttons: one to order a new consult and one to order a new procedure right from the Consults tab.  

The Consults tab allows the consultant to complete the consult by writing a consult note directly from the Consults tab. Now I do want to show you that because it is an important part of managing consults if you are a consultant. To complete a consult, it needs to be linked to a special type of progress note. A consult-specific type of consult note. Dr. VeHU Zero wears many hats in our VeHU hospital. Today Dr. VeHU is a surgeon and has a consult to orthopedic surgery service that needs to be completed. Here is how to do that in the Consults tab. 

Select the Orthopedic Surgery consult.

Now select the Action menu. 

And again select the Consult Results selection.

And then select Complete/Update Results.

Now this looks familiar. We have a Consult Note Properties box that opens. The Consult Note Properties dialog allows us to select a consult-specific title. But notice I have a predefined consult title listed here as well. By the way, if you want to know how to do this check out the Customizing Your CPRS and Tips and Timesavers topic on how you can predefine these default consult-specific titles instead of having to wade through the whole list of consult titles, which is a huge timesaver. Select the orthopedic surgery consult note title. Select the OK button.

Ah, just like in the Notes tab, we have now a screen that allows us to enter our consult results. We can write the note here, so simply enter this text as your note. We will schedule patient for surgery ASAP.  Okay, now let's sign this note, just as Neil described on the Notes tab. I'm going to right-click inside your note.   Now I would like you to select Sign Note Now. 

Our Sign Note dialog opens. Please enter vehu00, that's V-E-H-U-0-0 as the electronic signature code.

And then select the OK button.

Observe what happens to the orthopedic consult status. It is now complete and the consult has a linked consult note attached to it. And what is really nice, is that this consult note is also listed on the Notes tab as well at most VA hospitals. And again the ordering provider will get an alert with the consult results, if that provider has that notification enabled. Thank you for visiting the Consults tab with me. I'm going to make a short consultation with a bag of peanut M&Ms. Take a deep breath. We only have four more CPRS chart tabs left.

Topic 16:  Surgery Tab
Alright, let's continue our tour of the CPRS tabs.  Select the Surgery tab.

The Surgery tab is very similar to the Notes tab. It is here we can see the surgery cases that have been entered on our patients.  As far as entering operation reports, at most VA Medical Centers, the op report is dictated, downloaded, and verified by your Health Information Management Service specialist before the provider can actually sign it.  Your site may allow direct keyboard entry of an operation report.  But before direct entry of an op report can occur, the actual time out of OR has to be entered for the case from within the Surgery software.  Ask your clinical coordinator if direct keyboard entry of op reports is an option at your medical center.  

If so, it is just a matter of selecting the case and entering the op report, very similar to the Notes tab.  Okay, let's review the operation reports.  

First, we need to open the Surgery Cases folder so select the plus sign to expand that folder.

Note the icons to the left of the December 10th intubation and also to the left of the December 8th left inguinal hernia repair.  What do those icons indicate?  How can we find out?  

Select the View menu.  

Choose the icon legend.

Ah, so the icon with the "N" is a non-OR procedure with attached report and the icon with an "O" is an OR case with the attached report.  

That's enough on icons.  Select the OK button.

You'll see, to the left of the icons for the December 8, 2006 left inguinal hernia repair with mesh that there's a plus sign next to that folder.  Select that plus sign to expand that folder. We will be able to see the operation report.  But the nice thing is, you can also see the nurse intraoperative report as well.  Let's see what the operation report is on this patient for left inguinal hernia repair with mesh.  Select the operation report.

And sure enough, there is our note to the right-hand side showing us all of the preoperative diagnosis and surgeon and the attending and the brief history and the operative findings.  Bring your attention back to the listing of cases under the left inguinal hernia repair with mesh and now let's select the nurse intraoperative report. And you can see what the nurse entered during the operation in the operating room.  You can use the scroll bar, just like you did on the Notes tab to scroll down through if you wished.  Ah, but there is more.   
Do you want to review the anesthesia report?  Again, under the left inguinal hernia repair with mesh, select the anesthesia report. And just like magic, you can review the anesthesia techniques and medications given during the procedure.  Isn't it nice to have all this data easily accessible to us?  So this is the Surgery tab.  By the way, my friend Sam, who I play tennis with, is a general surgeon and he said he was finishing up an operation once and was about to close, but his patient, awakes, sits up, and demands to know what is going on. Sam says, "I'm about to close."  The patient grabs his hand and says, "I'm not going to let you do that!  I'll close my own incision!"  Sam hands him the thread and says, "Okay, go ahead.  Suture self."  And this completes the Surgery tab and yet another bad joke.
Topic 17:  Discharge Summary Tab
So from the Surgery tab, we go to the Discharge Summary tab. Please select the Discharge Summary tab.

This tab is also very similar to the Notes tab where it will list all of our discharge summaries. There is a View menu where we can change our default view, just like we could in other tabs, and filter the list by author, etcetera. We don't need to hash over that again. In addition, the Discharge Summary tab can allow us to enter a new summary by using the New Summary button below. We'll chat more about that shortly.

First things first, let's view a discharge summary.  Please select the discharge summary dated January 3, 2003. And we can see the admission diagnosis, 

the discharge diagnosis, and the typical things that you would see in a discharge summary for this patient. If your VA Medical Center has inpatients, they may require or offer you the ability to dictate the discharge summary, which then gets uploaded and verified again by your Health Information Management Service specialist, and then sent back to you for signature via an electronic notification. And other VA Medical Centers may allow you to do direct keyboard entry of a discharge summary, offering some nice templates to assist you. You sign it and shazam!  It's ready and available as a completed discharge summary. Many sites have templated titles specifically for a patient observation discharge summary as well. Some sites, like the Durham VA Medical Center, may even have customized discharge summary templates specific to a particular specialty service.

I need to mention that some VAs that allow direct keyboard entry may also require a verification process by a Health Information Management specialist after you've enter the summary and initiate the signature dialog. This process, the verification requirement, may also include business rules that won't allow viewing, editing, printing, or even signing of that unverified discharge summary. The fallout to you is that when entering a discharge summary manually at sites with this type of verification requirement, you would need to finish it, and fix all of your errors before trying to sign it, since at these sites the signature action actually sends the summary directly to the Health Information Management specialist for verification. 

Instead of covering how to enter a discharge summary, which is just as easy as entering a progress note, I suggest you inquire what process is used at your medical center. Entering a discharge summary does require you to link it to the inpatient visit and also specify who the attending is. If you are the author and the attending, you would need to enter your name in the attending field as well.

If your medical center does allow direct keyboard entry, consider these two points: Simply copying and pasting in an enormous amount of information may not be the best way to document a patient's hospital course.

A concise problem-focused summary which contains the required key elements will help the receiving physician much more quickly identify and how to respond to the patient's hospitalization. That's it. This concludes our tour of the Discharge Summary tab. 
Topic 18:  Labs Tab
The next tour of tabs in CPRS will be the Labs tab.  The Labs tab, that has a nice ring to it.  I bet my chocolate Labrador, Maggie, would like this Labs tab.   

Bring your attention to the chart tabs at the lower portion of the CPRS window, and select the Labs tab.

I like the Labs tab, it has some pretty neat features.  Now that we're on the Labs tab, let's review what we have here.  We have a list of the types of lab results that we can view on the left-hand side, the pane listed there.  But let me just point out that the Labs tab is for reference information only.  It only shows you the results of the lab tests.  You cannot place orders from this tab.  Visit the Orders tab for placing lab orders.  So the default view, when we come into this tab, is the most recent lab results.  There are buttons that are labeled Oldest and Previous and Next and Newest. Lab tests are displayed to us, with this particular report, with the most recent displayed first. Which in this case is a culture and susceptibility.  Ouch, kind of looks like strep.  

Please select the Previous button.

It will just go back to the previous lab collection date and time that it finds.  And in this case, it is a cholesterol value of 150 dated August 22, 2009.  I can see I am going to get carpal tunnel syndrome doing this Previous button selecting thing over and over again.  So instead, let's look at a different type of lab report.  Select the cumulative report on the left-hand side.  It is located within the Lab Results list box.

This lab report has different headings that are associated with it. In this case we have a chem profile, miscellaneous chem and a microbiology profile.  You will see that by the list of headings that are highlighted in the middle of the screen.  Down below, we can select our date range as well.  This report defaulted to six months for us.  I want to change the date range of this report to two years.  Note,  you can't use the scroll bar in this training so I'm going to scroll down to select the two years date range.  

When we do that, we can see that our headings now have changed because, during those two years, the patient had lab tests in different lab accession groupings.  For example, hemoglobin A1c is now included.  So we can see those.  So if I wanted to just see this patient's hemoglobinA1c results, I could select the hemoglobin A1c heading.  Please do that.  

Under Headings, select HGB A1C.

And it will jump us right to that accession area for those results in the cumulative.  Let's look at a different report.  On the left-hand side, let's choose All Tests By Date. And again, we have a date range setting.  And this is just a very linear report with the most recent on the top.  So if you like data in a nice chronological order, this is the report for you.  Now please select Selected Tests By Date.   

This is where we can actually say, show me only these particular lab tests.  

Type in "glucose" in the input box for Laboratory Tests. The Add button will now be enabled. 

Select the Add button to move that over to the right-hand side. Now we have the glucose selected.  Let's select another test.  I have placed the cursor back into the input box for glucose.  Please type in "Hemoglobin."

Select the Hemoglobin A1c. 

Select the Add button which moves it to the Tests to Be Displayed list box right underneath our glucose.  

Now select the OK button.

And there you have it.  We have our hemoglobin A1cs and our glucose values listed during a particular date range.  In this case, two years, listed in chronological order, most recent at the top.  There is another report that is very sweet.  It's called the worksheet.  

Let's select Worksheet under the Lab Results listing.

Let's select the same tests.  For laboratory tests, let's go ahead and type in "Glucose" again under that Laboratory Tests input box.

And add it over to the Tests to be Displayed list box by selecting the Add button.

And now let's select in there again.  I want you to type in "Hemoglobin."

Now I'm going to double-click the hemoglobin A1c, which also adds it over to the test to be displayed list box.  

We could keep adding tests if we wanted and as long as we don't go over seven selected tests we can actually save this as a new worksheet.   If we add more than seven tests, however, the new button which is located under the text "Define Test Groups" will automatically disable.  Don't let that discourage you, your worksheet can have more than seven tests. The limitation is only on the number of tests in each group that you create.  So you could have two test groups created that each have seven tests.  And then you can select both of those test groups to display as your total worksheet.  Anyways, we only have two tests,  so let's create a new worksheet for Dr. Zero VeHU.  Please select the New button located under the text, "Define Test Groups."A Confirmation will open.  

Select the Yes button.

We now have a new test group in our Test Group list box.  I will mention that you can also borrow other providers' test groups that they have created by simply selecting their name from the pull-down list located under the Persons with Defined Test Groups heading.  I will leave this to your own exploration.  Okay, let's display our hemoglobinA1C and our glucose values from our test group that we have just created.  Since we already have those tests selected, simply select the OK button.

And you will get a grid format of your selected lab values.  And this is really a pretty nice report.  Please select All Results, in the left-hand side towards the bottom, so we can get some more data points.

Now select the checkbox for Abnormal Results Only.

And it would only show us the abnormal glucose values and hemoglobinA1cs.  Let's uncheck that Abnormal Results box now by selecting the checkbox next to Abnormal Results Only.

Also note that you can also graph lab results.  So on the right-hand side of the screen, there's a radio button next to Graph.  So please select Graph.

And it will actually graph the lab values.  In this case, it's graphing the glucose that was highlighted.  And it shows you the reference high and low ranges through the date range.  If you like, you could also graph the hemoglobin A1cs as well. 

Select the Values checkbox.

It will put the values of those lab tests on the graph for us.   I like this Labs tab.  Bring your focus back to the left-hand side where it says Lab Results.  There is also a selection to graph there.  This, however, is a more detailed type of graph using the enhanced graphing tool.  As a side note, this tool can also be accessed from anywhere in CPRS via the Tools menu by selecting Graphing.  The enhanced graphing tool allows you to graph different data elements, like lab results and medications all on the same graph.  I will leave this option for your own exploration, but there are other Web-based training classes available on this tool as well.  So let's move on.  

Select the microbiology report.  

Hmmm, no results displayed.  What's up with that?   Note that the default date range is only going back seven days which is a pretty limited date range.  I'll show you how you can change that default date range later in this presentation under the Customizing Your CPRS and Tips and Timesavers topic. 

But for now, select the date range for two years back.

And our culture and susceptibility completed August 26, 2009 gets listed for us.  Okay, let's move on to another item.  

Now select up in the Tools menu. 

I see the graphing tool towards the bottom,  but there's also an option called Lab Test Information.  This particular item shows up in all of the other tabs under the Tools menu as well, which we didn't point out earlier, but we're pointing it out now. 

Select Lab Test Information.

A Lab Test Description dialog opens.  Here you can easily find out information about a lab test.  Let's find out information about hemoglobin A1cs. 

So let's type in "Hemoglobin."  

Go ahead and select the hemoglobin A1C in the list.

And you can see that information is displayed about our hemoglobin A1c, how much it costs, the highest urgency allowed, the lab collection samples must be lavender type of blood collection sample.   And additional information about this test that's required by the lab as well as the reference ranges.  Nice, pretty nice.  

Go ahead and select the Close box in the Lab Test Description dialog.

The Labs tab also allows you to get results for anatomic path including autopsy, cytology, electron microscopy and surgical path and blood bank.   We'll bypass those reports.  This report is very useful to see what status your lab order is really in.  Has the blood been collected yet?  Has it been cancelled?  Has the test even been accessioned by the lab yet?  

On the list of available lab test reports on the left, select Lab Status. It's the bottommost report.

This is a nice report for you to see what is going on with the lab test that you ordered.  For example, about halfway down the screen the cholesterol test from 8/25/09 has been collected, but not yet resulted. I hope you have enjoyed the Labs tab.   Wow, only one more tab left. 
Topic 19:  Reports Tab: Local Reports and Results
Alright, let's continue our CPRS tab-by-tab tour. Select the Reports tab. Ah, the power of CPRS.

Since all of our clinical software packages are interfaced, you have the ability to get results displayed to you via the Reports tab. Results on pretty much everything. I've decided to divide the Reports tab tour into three parts. Part 1 will be local reports and results. Part 2 will be how to retrieve data from other medical centers using CPRS. And Part 3 will be how to retrieve data from other medical centers using a Web-based program called VistAWeb. Take notice of all of the available reports listed.

Note that some of the reports have a local only suffix, like Imaging Local Only. This means that this data component will only display imaging data from your local VA Medical Center. It will not display an off-site imaging report performed at some other VA hospital. I want to mention that without demonstrating, two reports listed here that are extremely useful for hospitalists. These are the Med Admin Log (BCMA)and the Med Admin History (BCMA) reports. BCMA stands for Bar Code Medication Administration. These reports will show you the actual time your in-house patient received their medications that you ordered. Since our patient today is an outpatient, I don't have any med administration data on them. But I wanted to verbally mention these reports to you. Note that some of the reports listed are actually category headings of reports and those are ones with a plus sign prefix. For example, the Clinical Reports category has a plus sign prefix.  

Let's open up that Clinical Report category by selecting the plus sign.

When you do that, the Report category expands and now can see all the clinical reports that are available to us. Some of these reports listed are also categories. The reports listed contain data that is available throughout CPRS in other tabs, but the Reports tab is like a one stop shopping area for your results reporting.  

Let's select Allergies, for example, under Clinical Reports. And it will show you the list of allergies on our patient. Now go down to Pharmacy and select the plus sign next to Pharmacy. And let's select All Outpatient medications.

Behold, we have a list of all outpatient medications and their statuses are listed. But the most powerful thing about the Reports tab with this particular report that we've listed, is the ability to sort the drugs by selecting the heading in the grid that looks like a spreadsheet.  Example, in the grid, select the drug name heading.

And now you can see that all of the medications are sorted in reverse alphabetical order. If you select the drug name again, the drugs are now sorted in alphabetical order.  

Now select the Status category. And it shows us, in order, which ones are active. 

And if you select Status again,

it will reverse the sort. Okay, I want to show you another report because I want to show you how default date ranges can, in some cases, make it look like the patient has no data. So within the Clinical Reports category find and expand the Radiology category.   Within the Radiology category of reports, Please select the report titled "Report."

When you do that, no reports display to the right. What is our date range? If you note at the bottom left of CPRS the date range is defaulting to T-7 days to today. A one-week date range for this type of report is not very useful clinically.  

Let's open that date range by selecting the all results date range. When we do that, we will see the knee 2 view from 3/1/2006 as well as a chest X-ray from 3/1/2006 as well.  

Please select the knee 2 views report that is listed in the radiology report list box. 

You will see the report text listed at the bottom of the screen. But why did the software default only to seven days in the past for this Report? I will show you shortly.  

Now please select the report titled, Imaging Local Only. This report, by definition, will only display Imaging reports from your local medical center. Again, when we selected Imaging Local Only, no imaging reports display.

But note to the right of the list of available reports, above the columns where examinations would display. There is a heading titled Radiology Imaging Local Only From October 7, 2009 to October 14, 2009,max per site of 10. This is telling us that our default date range for this report is October 7th to October 14th and that the maximum number of reports that would be returned would only be 10. A very tight date range and only 10 reports returned from each site. Where does that default date range and max reports per site get set at? And more importantly, note in the lower left-hand CPRS window, that this time we cannot select a wider date range.  That's weird.   
Why can't we do that? Well, the reason is some reports can have a default date range predefined by you and some of those reports will allow you to open that date range on-the-fly. And some simply default to the date range with no on-the-fly changing of those date ranges.  How can we tweak the default date ranges for our reports?  Well normally the CPRS View menu allows us to customize our date ranges.  But for the Reports tab, it is different because there's so many types of reports that are involved. Let's modify our report titled Imaging Local Only date range to go back about five years and also change the maximum reports per site to 100.  

Select the Tools menu.  

Then choose Options.  

An Options dialog box will open. We will be going over this little gem in more detail later in the presentation in the topic called Customizing Your CPRS and Tips and Timesavers. But I want to show you how to change a report date right now.  

Select the Reports Options tab.

Now select Set Individual Reports.

Now, we need to find our Imaging Local Only report and see what the date range is defaulted to.

I'm going to scroll down the list, notice all the reports date range settings. Most are set seven days into the past.  This is a pretty tight date range that which we purposely set for this demonstration.  Notice the report labeled Imaging Local Only with a lowercase "R" in brackets after it. The "R" in brackets means that this report lives on the Reports tab versus a lowercase "L" in brackets, for living on the Labs tab. Note the start date for this report is hard-set to seven days before the end date. Let's change that. This will be a hard-set date to always begin on January 1, 2004 no matter what the end date is.  Now select the value of 10 located in the max column.  Change that value to 100.

I'm going to continue to scroll down the list. So let's also fix our radiology report date range. Find the Report titled, Radiology Report. The date on that is hard-set to seven days in the past as well. Again, that's a pretty limited date range for imaging. I have selected the start date.  Set it to T-1825,   which is five years in the past relative to the end date.  Select the 10 located in the max column. And change that to 100.Select the OK button.

And then select another OK to exit the Options dialog. Once we exit this dialog, CPRS refreshes, and as a result, the Clinical Reports category collapses.  

So, again, expand the Clinical Reports category.

Then expand the Radiology category.

Now, let's reselect the Imaging Local Only report.

Ah, that's better, the knee X-ray from March 1, 2006 is now displayed in the list and note the date range.  

And also note that the knee X-ray has an icon next to it.  That icon is an indicator to you that this is an examination that has digital images that you can view. I will show you the VistA Imaging viewer program later in this presentation.  

A truly integrated medical record allows you to access to all information, whether it be text-based reports, graphs, digital images or digitally scanned documents. That's pretty awesome.  

Now under the Radiology category, select the selection in the list titled, Report.

And now that report also defaults back to over five years, October 15, 2004.  That is much better. So, the take home message for any of these reports on the Report tab is to be aware of the date range filters as well as the maximum number of reports returned filter and know that you have control over that date range. But there is a trade off, you don't want to set date ranges so far in the past because it could slow down your system response. But, in my opinion, knowing you have control over those date ranges and how to set those ranges is what's important.

Topic 20:  Reports Tab: Using CPRS Remote Data View
So now let me show you another nifty feature of the Reports tab. You remember that our veterans can be seen at other VA hospitals throughout the country as well as the Department of Defense facilities. The nice thing about our application is that it talks to all those other VAs. We can actually retrieve data from other VA Medical Centers and the Department of Defense directly from within CPRS.  Roll up your sleeves; it is time to go get some remote data.  

You'll notice up in the information bar where the patient's name is listed, toward the right, there's a button called Remote Data. Is it colored blue? If it is, that is a visual indicator to you that your patient has visited other VAs or has Department of Defense, known as DoD, data.  

Let's select the Remote Data button, which will show us and allow us to select, which sites to query remote data from.

Note the list. Our patient has potential clinical data from DoD and the Upstate New York Health Care System. In addition, our local medical center is not listed in the list because it is assumed as the local site. In this example, our local site is the White River Junction Medical Center here in Vermont. In the case I want to present,  this patient has mentioned to you that he has had knee X-rays from the Department of Defense as well as from the White River Junction Medical Center in Vermont.  

Let's select all available sites, in this case which will include DoD and Upstate New York and White River Junction. 

By the way, it is important to choose the sites to query before selecting the actual report you wish to retrieve.  Also notice once we've selected all available sites, how report tabs now appear in the center of the CPRS window for local, Department of Defense and the Upstate New York HealthCare system. Also, now that we have selected which sites to query, we could select the remote data box again, just to make that expanded window go away, but I like to suggest keeping it open because it will give you an indication when the remote queries are actually completed. Be aware that remote queries are not instantaneous. They may take several minutes depending on how many sites are being queried and how much data that you've asked for.

Okay, so since our patient has Department of Defense imaging reports,  let's expand the Department of Defense reports category on the left under Available Reports, by selecting the plus sign prefix.  Within the Department of the Defense available reports, please select the Radiology Report selection.  

When we do that, since we've selected remote sites to query the remote data dropdown box reports to us that those available sites are being queried.  The status of the query is reported and when the query is finished the word "done" will be displayed as a suffix. That is why I like to leave this remote data window open so I can see when the query is actually finished. Also note that the date range that was queried for this report is listed as T-604 to today. Why do you think that the DoD radiology report used that default date range?  I bet if we went to the Tools menu, and under Options and checked the default date range for this DoD report we would find this default date range specified as the start date. Anyways, take note that no reports were returned during this date range so I suggest that we open up our date range on-the-fly by selecting the all results date range.

Do that, select the All Results selection in  the Date Range window.

Ah, that's better. We now have films from White River Junction, Vermont, the Martin Army Community Hospital, Guthrie Army Health Clinic, and the Womack Army Medical Center. Just as an aside, these grid-type formats allow you to sort by any of the headings.  For example, we could easily sort these by procedure name by simply selecting the procedure name heading so that all the knee reports will be grouped together. And then we could easily view any of these reports by simply selecting the procedure name listed in the grid. That is how to view remote reports, whether they are DoD reports or other reports from remote VA Medical Centers that the veteran has visited.  

Let's do one more query for medications and let's look at DoD medications as well. Under the Department of Defense reports category, select the Pharmacy All Outpatient report. This report doesn't have date ranges, it just returns all medications. You'll see the list of meds, including DoD. Let's sort them by status, select the Status heading.   

And now let's view the sig for the White River Junction Vermont colon prep. Select the White River Junction colon prep from the list.  And you will see the med details below. 

Under Available Reports, please select the health summary plus sign to make it expand.

Health summaries are reports that can be created and customized by your VA hospital. So you can add any type of health summary here with collaboration with your clinical applications coordinator. Some health summaries are standardized and released nationally.  These have the word "remote" as a prefix. For example, note the remote immunizations all health summary in the list. So a physician can then select that and quickly get reports of immunizations on his patient.  Let's go ahead and select the remote immunizations all health summary. The remote sites are queried and you can see the tabs across the report display area, each tab representing the site that was queried, in our case local, White River Junction, Department of Defense, and Upstate New York Health Care System. And by selecting those site tabs would display the data to you. You can see that at our local site, our patient has had a tetanus immunization. Select the Upstate New York HealthCare System report tab.

Looks like out veteran had influenza and a Pneumo-Vac immunizations at the Upstate New York Health Care System. Finally as an inherent feature of remote data queries, if you have selected sites to query the Labs tab automatically will show you remote labs. Let me show you that.  

Select the Labs tab.

The most recent report is the default report when you enter the Labs tab.  However, select the cumulative report from within the labs results list of reports.

When you select that, those remote tabs automatically appear again because the cumulative report is a report that is considered a remote query report.  We see data from our local site.   Select the Upstate New York Health Care System report result tab.

Behold, there are lab results from New York Health Care System as well. In summary, the health summary is a collection of data. It can be a collection of radiology reports, immunization and skin tests, lab results, all in one concise report that you can display and actually print and give to your patient. And this could be really helpful if your patient is being seen by an outside cardiologist, for example. You could print out a canned health summary that includes their allergies, radiology test results, cardiology tests, lab results and their medication list to give to your patient - if they have a signed release of information - for them to take and show their outside provider. This ends my session on using the Reports tab and the remote queries of data using CPRS Remote Data Views. Stay with me for the next topic, Using VistAWeb for Remote Data because it's a very nice Web-based interface for querying remote data. 

Topic 21:  Reports Tab: Using VistAWeb for Remote Data
The final thing that I would like to show you that is related to the Reports tab is another way to query remote data using a totally different application. It is called VistAWeb. And it's a very nice Web-based point-and-click application that will allow you to retrieve remote data, just like that Remote Data View button that we went over, but a heck of a lot easier in my opinion.  I'll retrieve the same reports as we just did with the Remote Data Button, so you can compare the applications. Let's go back to the Patient information header. Right above the Remote Data button is a button labeled VistAWeb. Please select the VistAWeb button in the upper right-hand corner.  
The VistAWeb application will open up and allow us to query data on our patient from all VAs. As a side note, the first time that you ever use VistAWeb you will need to authenticate by signing on again, so you'll need to enter in your access and verify codes.  Then, from that point on, VistAWeb will not prompt you again for your codes. For this Web-based training, I don't need to enter my codes again. The VistAWeb application is CCOW-aware. You remember CCOW right?  We covered CCOW in the introduction slides and also on the Cover Sheet topic of this presentation.  CCOW is the ability of an application to automatically select the same patient. It's called patient context. Here's a pretty good example of it. This application is another graphical user interface, and it's saying, wait, hey, wait a minute. I know about Patient Twenty. Do you want me to use that patient in this VistAWeb application? So it saves you from having to select the patient again. We do want to query remote data for Patient Twenty, so select the Proceed button. And you are now presented with a Web-based application, almost like any Web page, that has data hyperlinks on the left-hand side. These data hyperlinks are pretty much the same as what displayed on the CPRS Reports tab. And  note the area in the center of the screen that is listing where the data has been retrieved from for this patient, in this case, the Upstate New York Health Care System, DoD which is Department of Defense, the HDR which is the Health Data Repository, and our local medical center, White River Junction, Vermont. 
 In addition, this Sites and Notices page shows us the date last seen at those facilities in one of the columns.  Note the data hyperlinks on the left-hand column. Some of those data names have a dagger or a cross appended to the name. This is a visual indicator that that data element can return Department of Defense data if the patient does indeed have DoD data. Examples are consults and procedures, discharge summaries, histories and questionnaires, etcetera.  Some data names have an asterisk appended.  That is a visual indicator that this data is being retrieved from the Health Data Repository. An example is allergies. Regardless, the meaning of these indicators as well as any future indicators that are added to this application, are all listed at the bottom of this window. Okay, first I'll show you the same query for imaging reports that we did in CPRS with remote data views.  First, select the plus sign next to Radiology, which expands that category. Now select the Radiology Reports data element.  That's the one that has the dagger appended, which indicates what was that?   Yeah, this element can return DoD data if it exists. VistAWeb queries all sites from our sites page. We get a message that says, "No radiology reports were found." But why? We know this patient has imaging data. What is our date range? Always be aware of what date range is being used in these queries. VistAWeb defaulted the data retrieval to one year.  I know this by looking at the radio button which is enabled next to the one year date range. Well, let's open the date range by selecting the radio button next to All Dates. Good, now select the Query button located to the right of those date range radio buttons. And wham, we get all radiology reports from Upstate New York, Department of Defense, and White River Junction Medical Centers.  
And, we can easily sort this data by any of the column headings. So let's sort these by procedure name. Select the Procedure Name column heading so that all the knee reports will be kind of grouped together. And we could now easily view the report text by simply selecting the View Details hyperlink located in the first column in this grid.  So it's as easy as that. Be aware of your date ranges if needed.  Make sure you open the date range if needed.  Remember that opening date ranges to all results may take the VistAWeb application longer to retrieve data.  Ok, more data. Let's select the plus sign next to Pharmacy. Note the All Outpatient data element. It has a dagger and an asterisk appended to the name. So it's DoD-aware and also has the data being retrieved from the Health Data Repository. Please select the All Outpatient hyperlink. And the data will be queried. Note, however that only one hydrocodone was retrieved.  Only one medication? Well, maybe not. What is our date range? Well VistAWeb defaulted this report to 15 months for us. Open the date range to all results now by selecting the radio button to the left of All results. And then the Query button. 
And we can now sort by the medication name. Select the hyperlink called Medication which is located at the top of the medication column, that is the second column from the left. And you can see that this Web-based application does the same thing as our CPRS Remote Data View application, but I think that you'll find this interface is a little easier to use. Date ranges are set differently, by radio buttons and there isn't really any way for you to preset default date ranges for yourself in this application. You can see, however, that it is very easy and obvious what date ranges are being used by simply looking at those radio buttons.  And for these reports, to see the details, you simply select the View Details hyperlink.  
One of my favorite reports in VistAWeb is the Consults and Procedures data element. This returns quickly any consult local and interfacility and the results from any site that the patient has visited.  It's a very nice report.  One more point to make. Be careful on reports that have maximum data per site defaults. Located in the lower left-hand side of the window, please select the Progress Notes data link. The query will begin with a default of one year of data but the maximum number of reports per site is defaulted to 50 notes including addenda. Our query on Patient Twenty returned no progress notes for that date range. I'd ask you, if we opened the date range to all dates by selecting the radio button next to All Dates, would we definitely get all progress notes on this patient? Well, maybe not.  If the patient had 100 progress notes at White River Junction VA, the query would only return the most recent 50 of those notes because of the maximum number of notes per site is automatically preset to 50. 
So if we really, I mean, really wanted all progress notes, we could select the All Dates radio button and in addition, select the checkbox to the left of all reports. Be aware, doing this on a patient who has been seen at several sites and who has a lot of data can cause your query to take several minutes. We could probably meet our clinical application coordinator for a quick cup of coffee and a donut while this query was retrieving. Well let's be sassy and let's do that.  Select the radio button next to All Dates. Now select the checkbox to the left of All Reports. Now select the Query button.  And when the data returns, we have a lot of notes,  including some post-deployment health assessments from the Department of Defense.   We are done. Take home message for reports, including remote queries, is to be aware of any default date ranges or maximum number of reports per site. If you expect report data and you do not get that from query, note your date ranges and adjust them as necessary.  This concludes the Reports tab and the remote data query tours.  Now Neil will tell you everything you need to know about notifications. 
Topic 22:  Processing CPRS Notifications
Well, we've come full circle now. We've worked our way through each of the tabs in CPRS and reviewed remote data access. And so you probably thought you were done, but not quite. There's more. In this section, we're going to discuss notifications, which are also referred to as alerts. We're currently here on the Reports tab, where Rick just finished up. In order to look at the notifications, we need to go back to the Patient Selection screen. 

Go to the File menu.

And choose Select New Patient.

Alerts, or notifications, are an important part of CPRS, as this is the way information filters back to you.  

Here you can be notified of lab results, imaging results, pathology results, consult requests to your service, results of consults that you've generated, patient admissions and discharges for your paneled patients, orders flagged to your attention, and notes sent to you for cosignature or additional signature.  
Let's take a look at the Notifications window. I should mention that the window can be resized to allow more or fewer notifications to appear in the window. And the size that you choose will be preserved as you move between patients. Okay, so here in our Notifications window, we can see all of the notifications that have been sent to us.  Notifications come in two different forms, informational alerts or action alerts. Look at the column furthest to the left, with the title "Info." If the letter "I" appears in this column, you'll know you are looking at an info or an informational alert.  Info alerts contain all the information there is to be had within the text of the alert itself. When you process an info alert, it just goes away. You aren't taken into that patient's chart. Let's look at an example. 
About halfway down our list of alerts, you can see an alert with an "I" next to it, letting us know that our patient, Mr. Seven has been admitted and we're told the location 3 North Surgery as well.  Since this is an informational alert, we won't be taken into the patient's chart when we process the alert. The alert will just go away. I'm going to double-click on the alert. And it's gone.  Ok, now we'll look at an action alert. It looks like our favorite patient, Mr. Twenty has a hemoglobin A1c result waiting for our review.  Now I'm going to double-click on it to process the alert. 

And as you can see, we've been taken directly into Mr. Twenty's chart and presented with the hemoglobin A1c result for review. Look in the lower right-hand corner to find a button that says "Next" with a finger pointing to the right. 

Select that button to move back to the Patient Selection screen. Now, let's go over a few timesavers you can utilize when viewing and processing your alerts, namely sorting alerts, processing multiple alerts in sequence, and renewing or forwarding alerts. Alerts can be sorted by selecting on any of the column headers.  The default sort is based on the Date/Time column and is in reverse chronological order. Let's sort now by patient.  

Select the column header that reads "Patient."  

The alerts are now sorted so each patient's alerts are next to each other, in reverse alphabetical order.  

Select Patient again.  

Now they are sorted in alphabetical order. Now let's process a sequence of alerts.  

I'm going to hold down the Shift key. As you can see, when I pressed Shift and selected another alert, all the alerts between the first one that I selected and the second one I selected were highlighted.  So using Shift allows you to select alerts in a series.  Now, let's add a single alert to our series for processing. To add or remove single alerts, press and hold the Control button and select the desired alerts to add or remove. I'm going to press and hold Control now and select the alert for the order that we flagged earlier. So let's process this series of alerts.  

Select the Process button.

When processing a series of alerts, we'll be using the Next button in the lower right-hand corner to move between alerts. But the Next button can do even more. I'm going to right-click  on the Next button so you can see the other options available to you.  As you can see, we can use this button to forward alerts to another provider or to renew an alert we've just processed, preserving it in our notifications box to come back to later. Let's forward this current alert that we're looking at about a cancelled consult to a colleague we think should be aware of this. 

Select Forward.

We can enter a comment.  

Type "FYI."

And now we need to select a recipient for our forwarded alert. Let's select the first provider in the list, Access, New. Now select OK.

And this alert has been forwarded to the designated provider.  Now select the Next button to move to our next notification. Here we see a cardiology consult result for Patient Thirty. Perhaps this is something we need to come back to later and we realize we don't really have the time right now to process this alert, we don't want it to go away, we'd like it to stay in our notifications box for later reference. Let's renew the alert.

I'm going to right-click on the Next button.

And you'll see the option for renewing this notification.  Select Renew.    

And that's it. Now, the cardiology consult notification for this patient will still have its place in our list of notifications when we return there. Ok, let's move to the next alert. Select the Next button.

We've been presented with the patient record flag for Patient Twenty. Select Close.

And here we find the order we flagged during the tour of the Orders tab. We could unflag it if we wanted, but for the sake of time, let's move on.

Select the Next button. 

And look. Apparently, we've finished our series of selected notifications. We've been returned to the Patient Selection window. Customizing which notifications you want to receive will be covered in our next topic when we review customizing your CPRS and tips and timesavers. I'll turn things back over to Rick. 
Topic 23:  Customizing Your CPRS and Tips and Timesavers: General, Notifications, Order Checks
CPRS is highly customizable, as is evidenced by its use across a very large health care setting by a tremendous number of users in a wide variety of settings from ambulatory care to the intensive care unit, from the operating room to the mobile clinic. 

What tools do we need to customize our CPRS instance? The tool we need is in the Tools menu. 

Many items can be added to the Tools menu by your Clinical Applications Coordinator. Links to Internet or intranet sites, links to other programs, can all be placed here to allow easy access to this information within CPRS. Select the Tools menu.

We have a few items listed here, VistA Imaging, iMedConsent, Dental Record Manager, a Mental Health Assistant, which is MHA, etcetera.  The items below the dividing bar - the graphing, lab tests, and options items - are always there and cannot be amended.  

Okay. To start customizing your CPRS, let's choose Options. The Options dialog will open. It is here that many of the important customizations of your CPRS GUI interface can be done. You'll note that there are numerous tabs, each which allows you to change different things. This module is going to cover all of these items so you can be a CPRS tweak geek. Let's start with the first tab in the list.  The first tab that is highlighted is called the General tab.  It is here where we can change the date range defaults for the coversheet.  

We can review the clinic reminders that are displayed on our coversheet 

we can configure some other parameters like the default Chart tab and Meds tab date ranges as well.  

But let's start from the top.  

Select the button labeled Date Range Defaults. 

A Date Range Defaults on Cover Sheet dialog will display and it is here where we can change date range defaults for our lab results and our appointments and visits data views on the Cover Sheet. I am going to leave the lab results date ranges the same but notice that the start date for the appointments and visits on our Cover Sheet is set to 60 days.  I would like to open that up to display previous clinic appointments for the past year on my Cover Sheet.   I'm going to place the cursor inside the input box 

and highlight the today minus 60 that is there.  

I would like you now to type, "T-365."

At this point you could bail out by selecting the Used Defaults button. But in this case,  I like what we did, so select the OK button. It's as easy as that. Let's move on. Select the Clinical Reminders button.

This will allow us to configure which clinical reminders are displayed on our Cover Sheet. A clinical reminders and reminder categories displayed on Cover Sheet dialog opens up. I'm not going to spend a lot of time on this, but this configuration can allow you to add or remove clinical reminders from displaying on your Cover Sheet. Most of these will most likely be locked down to not allow removal and I would caution you about tweaking this particular option.  So for now let's just move on by selecting the OK button. 

The next little parameter is a real gem.  The Other Parameters option will allow us to configure the Chart tab settings, the date range defaults for the Meds tab, and change the date range for which appointments will display when we create a new visit. All very nice parameters to tweak. Select the Other Parameters button. Bring your focus to the initial tab when CPRS starts input box.  The Cover Sheet is our default, and we can change that to any tab we wish.  In this case let's change it to default to the Notes tab.  I'm going to select the little down arrow to the right. And I would like you to select Notes.

Now when we initially open CPRS, the Notes tab will be our default tab instead of the Cover Sheet.  

Also note that the checkbox next to "use last selected tab on patient change" is enabled. This means if we had Patient A's chart open and we were on the Orders tab for example, and then we selected a new patient, say, Patient B, Patient B's chart would automatically open to the Orders tab because that was the last tab that we had selected. So I'm going to just leave that enabled.  

In the center of the dialog is where we can set the date range for the Meds tab. Be a little careful with this setting.  If you have too tight of a date range, some medications may not display on the Meds tab if they fall outside of your start and stop date ranges. I am going to leave the Meds tab date ranges as they are.  

At the bottom of the dialog is where we can set our start and stop date ranges which are used to select a previous clinic appointment when we were selecting an encounter location for our activity.  Again, I am going to leave these dates as they are in this particular example.  We are finished with setting other parameters, so select the OK button at the bottom of the dialog.

Now I would like you to select the Notifications tab within this option.  

Okay again, let's start at the top and move our way down. The checkbox next to "send me a MailMan bulletin for flagged orders," if enabled, would send you a MailMan message in the VistA applications MailMan program. Note that that mail program has nothing to do with Microsoft Outlook. If enabled, you would get a MailMan bulletin if somebody flags an order that is attached to your name.  This is assuming that you do read your VistA email.  Note the Surrogate Settings button. If you go on vacation for a week and you have someone covering for you, that person can receive your notifications as your surrogate.  

Select the Surrogate Settings button.

We could type our surrogate's name in this box but I'm going to select the down arrow button and I would like you to choose the first provider on the list which is "Access, New."

When we choose a provider,  

the Surrogate Date Range button becomes enabled and allows us to select the date range that our surrogate will receive our notifications. Select the Surrogate Date Range button.

And again, a date range dialog opens and allows you to specify a start date and a stop date. We are not going to do that, so select the Cancel button.

And I decided not to set a surrogate, so select the Cancel button again.

And by the way, this is also where you could go to remove your surrogate as well. If you set a date range and return when expected, removing the surrogate isn't necessary.  

The next button is the Remove Pending Notifications button. Some VA Medical Centers may have a policy in place where they have disabled this button. Otherwise, if you select it a warning message would appear and you could remove all of your pending notifications. We are not going to do that, so let's move on.  

Neil discussed how to process notifications. This option is where you can enable or disable which notifications that you wish to receive. Again, some medical centers may have many of these set to mandatory so you would not be able to turn those off.  Otherwise, this is pretty self-explanatory.  You can either place a checkmark in the box to turn them on or uncheck them off. I encourage you to at least review what notifications are available to you at your leisure.  Okay, let's move on to the next item that we can customize.  Select the Order Checks tab within this dialog.

This is just like setting which notifications that you wish to receive and it's pretty self-explanatory. Order checks can alert you on specific items when you are placing an order. You can either place checkmark in the box to turn them on or uncheck them off. Again, some are mandatory. I encourage you to scroll through the list at your medical center to review what order checks are enabled at your institution.
Topic 24:  Customizing Your CPRS and Tips and Timesavers: Lists/Teams
Okay the next item in Options. Please select the Lists/Teams tab. This is one of the best timesaver options I can think of. It is here you can customize which patients are presented to you for selection when you are trying to choose a new patient. This is a place where you can customize and allow a different clinic each day, the clinic that you're in, and the list of patients to appear as your default patients to choose from. In the example I want to present, I am going to build a combination list of patients because I see patients in my cardiology clinic and also in my primary care clinic. 
We will then set that combination list as our default list in CPRS which will be presented to us at Patient Selection screen. So let's go.  The List/Teams options tab allows you to do a few things. Set your patient defaults and also manage your personal team lists.  Let's start with patient selection defaults and create a source combination.  Select the Source Combinations button.  

Our source is going to be a few clinics, but it could be a combination of patients in certain clinics and wards or by assigned provider or specialty or even a personal list. Anyways,  select the radio button next to Clinic.   

This allows us to select which clinics to include in our combination list.  You're unable to double-click in this training, so I'm going to double-click the cardiology clinic, and then note how it moves to the right as a combination entry. Now I'm going to scroll down the list. I'm going to double-click the primary care Dr. Vehu clinic. Now we have two source  combination entries.  That is enough for now.  Select the OK button. Now here is what confuses people. We've only created the combination list.  We have not set it as our default patient selection list yet in CPRS.  Let's do that now. Select the Patient Selection Defaults button.

This little gem allows a lot of tweaking as well.  We just created a combination list source.

Select the radio button next to Combination located within the list source area.

At this point, CPRS now knows that our default list source is our combination list that we just created. But there is more we can do. We can tweak the sort order of our default patients. I want the combination list sorted by appointment date.  Usually the most practical sort in my opinion is sorted by appointment date.  So select the radio button next to Appointment Date located in the Sort Order area.

Next we need to define a date range for our combination list of appointments to use. So in the Start input box, let's leave today as the start date. In the Stop input box, I have highlighted the word "today." 

And I'll enter T+7, which is today plus seven days.  Now as a side note, I think most outpatient providers may find a start and stop date of today to be the most useful. But we are done. We could set clinics for each day of the week with this option if we wanted to, but you get the idea. Select the OK button to exit this dialog. And now I'd actually like to show you this. Select the OK button again to totally exit the Options dialog.

Now select the File menu.

And select New Patient.

And look what we have done. We have set a combination list of clinics which will list our patient from today to seven days in the future. Note that the list is sorted by appointment date and that both of our clinics are showing: the clinic for primary care Dr. Vehu, and also the clinic for cardiology. And by the way, if we selected a patient off of this list, the encounter location is automatically set for our patient. So we would never have to do that extra step of selecting the clinical location when you are writing a note or placing orders. That's nice and it's a great timesaver. Okay, I just wanted you to show you that. Wanted you to see it. Select the Cancel button.  

Now, let's get back into Options for more customizing. Select the Tools menu.

Select Options.

Select Lists and Teams again.

Let's discuss personal lists and teams. Select the Personal Lists button.  

More than likely you will get a message saying, "You have no personal lists.  Use new list to create one." So, select the OK button. We are going to create a personal list of our patients, our cardiology patients.

The thing about personal lists is if you create a personal list and add patients to the list, you are then connected to those patients.  In other words, CPRS can send you notifications on those patients even if you were not the ordering provider. Select the New List button. Name your list Cardiology Vehu.

Note that you could also specify who could see this list. For our example, let's leave it at myself only. Select the OK button. Now we need to add patients to our personal list. You can select patients by patient name, ward, clinic, provider, specialty, or by a list. Just leave the radio button next to the patient selection. I'm going to place the cursor in the patient input box, and I would like you to type in "one," O-N-E.  

Now, you're unable to double-click within this training so I'll demonstrate the next few steps. I'm going to double-click One,Imagepatient. I'm going to double-click One,Inpatient. Then double-click one,outpatient, and then double-click one,patient.  As I double-click these patients, they are being moved down into the patients to add list box. These are my cardiology patients. Now select the Add All button, which actually adds those patients to the personal list

called  "Cardiology Vehu."  

Select the OK button.

A confirmation dialog box will display. Select Yes.

And this brings us back to the main Options dialog. Let's move on.  The button called Personal Diagnoses List is most likely not enabled at your site so I'm going to skip that. Select the Teams Information button.

A Team Information dialog opens. This option simply allows you to view which teams you are a member of and possibly subscribe to other teams. Select the checkbox next to Include Personal Lists.

Select the Cardiology Vehu team. And you can see what patients are on this team.

Okay we are finished with this option so please select the Close button. 
Topic 25:  Customizing Your CPRS and Tips and Timesavers: Notes, Options, Graphs
Alright, the next item in Options, let's move on. Select the Notes tab within the Options dialog.  

This is a nice little customization gem. It allows four different types of customizations for our Notes tab. Let's begin with the first item on the list and select the Notes button.

Here we can see that the auto save interval for our progress notes is set to 300 seconds.  This is a good time interval.  No need to change it. If for some reason, your computer tends to cause you to lose notes, you could decrease this auto save interval.  However, I suggest leaving it at the default unless you have a coffee and donuts consultation with your friendly Clinical Applications Coordinator and are advised otherwise.  Next, we could enable the ability to be prompted for a one-line subject text field when creating a new note.  Let's leave that unchecked. Next, let's place a checkmark in the box next to Verify Note Title. 
The verify note title becomes useful later when I show you how to predefine your pick list of common note titles that you use.  For example, after defining a default pick list of  note titles, if you had one of those titles set as a default title, then this Verify Note Title is not checked, then when you start a note, your default note title would get automatically selected and the note editor would simply open immediately.  To change the title at that point requires a few additional clicks on your part.  

So Dr. Evans and I suggest always having Verify Note Title checked. The only exception is if you ever only use just one note title. Next, if your notes require a cosigner, a great timesaving tip for this setting is to be able to enter a default cosigner for your progress notes.  This is where you would set that default.  But let's move on. Please select the OK button.

The next item we can customize is our list of preferred progress note titles. This is an extremely important timesaver so you don't have to manually select your progress note title each time you create a progress note or a consult note.  I hope you will default your note titles and also show your colleagues how to do this as well.  Please select the Document Titles button.

A Document Titles dialog opens. Here we can predefine our list of note titles that we use by document class. We already have a general medicine note title in our predefined list. This option allows us to define our progress note titles, discharge summary default titles, and consult-specific titles as well.  The pull-down menu in the document class selection area allows us to choose which category of titles we will be defaulting. Let's leave that at progress notes.  I'm going to place the cursor within the document titles input box, and I would like you to enter the word "primary." 

We want the first three notes added to the list of our preferred note titles.  Now, you're unable to double-click within this training so again I'll demonstrate the next few steps.  I'm going to double-click the primary care follow-up note.  I'm going to double-click the primary care note. And the primary care telephone note. 

Double-clicking each one of those notes added the notes to our list of preferred titles.  In addition, we see patients in a cardiology clinic a few days a week so we have a few titles that we use for cardiology clinic that we should add to our preferred titles list as well.  One of these cardiology note titles is a consult-specific title.  Using a consult title, as you recall, is linked to the consult request and this would update our consult request status to complete for us as well as send the results to the ordering provider. 

So I'm going to completely highlight the primary care telephone note that's in the document titles input box.

Now that I've done that, you can type in the word, "cardio." And now I will double-click the cardiology clinic note.  And I'll double-click the cardiology consult note.  

By the way, the reason you may want to add consult titles to your progress note titles preferred list is if you complete consults from the Progress Note tab in CPRS as opposed to completing consults via the Consults tab in CPRS.  It's just a great timesaver. The other thing we can do is to set one of our preferred note titles as our default title. So whenever we started a new note the default title would be initially selected for us. The way to do that is to simply highlight one of your preferred titles and then select the Set to Default button.  Since we see patients most often in primary care, let's default the primary care note title as our default.  Select the primary care note title within the list of titles. 

And then select the Set As Default button.   

Note at the top now, the list of titles primary care note is listed as our default.  This is where the setting that we set earlier under the Notes option called Verify Note Title comes into play.  If we did not have Verify Note Title enabled, since we now have a selected primary care note as our default title,  if we started a new note, the editor would immediately select that title and start the new note.  By having Verify Note Title enabled, even with a default title, it would be selected but would allow us to easily select a different title before the note editor opens.  We recommend having Verify Note Title always enabled.  Now I want you to remove the general note title. So select the general medicine note title.

And then select the Remove button.

Now we should default to consults documents class list of titles because we complete consults from the Consults tab.  We will have a quick predefined list of consult titles to choose from.  I will go up to the document class list box and I will select the down arrow button. Now please select the consults document class.  It's the second one in the list.

You may get a confirmation dialog asking if we want to save changes to our progress note defaults.  Select the Yes button.

Ah, now we have document titles that are specific to consult completion being listed for us to select as a preferred consult title list. Note that we already have an orthopedic surgery consult title predefined in our list.  We'll leave that.  We also complete consults for cardiology service so I'm going to double-click the cardiology consult note title. Now select the Save Changes button.

And finally select the OK button. 

What this does is if we complete a consult from the Consults tab in CPRS, we will be presented now with a list of our preferred consult note titles. A very nice timesaving tip. And that is how to set progress note preferences.  Select the OK button, which closes the Tools Options dialog.

I'd like to show you what we just did.  Go to the Notes tab. Select New Note.

Note the Progress Note Properties dialog now.  All of our preferred Note Titles are listed and our default title, the primary care note is selected and automatically highlighted for us.  But we could select another note title right here because of the Verify Note Title checkbox. We are not going to write a note.  So select the Cancel button.

A consult title warning will display.  Select the No button. And select Cancel again.

More customizing to do. Select the Tools menu. 

Select Options.

The last two tabs on the Options menu are for reports and graphs.  The tab for reports allows customization of the date ranges on the Reports tab in CPRS.  We already discussed this earlier.  

The final tab on the Options menu allows you to customize the graphing tool. The graphing tool could be a presentation in itself and there are other Web-based based training resources available on this topic. So that's it.  We've made it through the Tools Options menu.  In summary, CPRS is highly customizable and is a very usable electronic medical record. We hope you've enjoyed your time with us, touring tabby tab through CPRS.  We  have included a very short demonstration on how to use iMedConsent and VistA Imaging as well.  If you have time, check those out. 

Topic 26:  iMedConsent
Alright, the next item in Options, let's move on. Select the Notes tab within the Options dialog.  

This is a nice little customization gem. It allows four different types of customizations for our Notes tab. Let's begin with the first item on the list and select the Notes button.

Here we can see that the auto save interval for our progress notes is set to 300 seconds.  This is a good time interval.  No need to change it. If for some reason, your computer tends to cause you to lose notes, you could decrease this auto save interval.  However, I suggest leaving it at the default unless you have a coffee and donuts consultation with your friendly Clinical Applications Coordinator and are advised otherwise.  Next, we could enable the ability to be prompted for a one-line subject text field when creating a new note.  
Let's leave that unchecked. Next, let's place a checkmark in the box next to Verify Note Title. The verify note title becomes useful later when I show you how to predefine your pick list of common note titles that you use.  For example, after defining a default pick list of  note titles, if you had one of those titles set as a default title, then this Verify Note Title is not checked, then when you start a note, your default note title would get automatically selected and the note editor would simply open immediately.  To change the title at that point requires a few additional clicks on your part.  

So Dr. Evans and I suggest always having Verify Note Title checked. The only exception is if you ever only use just one note title. Next, if your notes require a cosigner, a great timesaving tip for this setting is to be able to enter a default cosigner for your progress notes.  This is where you would set that default.  But let's move on. Please select the OK button.

The next item we can customize is our list of preferred progress note titles. This is an extremely important timesaver so you don't have to manually select your progress note title each time you create a progress note or a consult note.  I hope you will default your note titles and also show your colleagues how to do this as well.  Please select the Document Titles button.

A Document Titles dialog opens. Here we can predefine our list of note titles that we use by document class. We already have a general medicine note title in our predefined list. This option allows us to define our progress note titles, discharge summary default titles, and consult-specific titles as well.  The pull-down menu in the document class selection area allows us to choose which category of titles we will be defaulting. Let's leave that at progress notes.  I'm going to place the cursor within the document titles input box, and I would like you to enter the word "primary." 

We want the first three notes added to the list of our preferred note titles.  Now, you're unable to double-click within this training so again I'll demonstrate the next few steps.  I'm going to double-click the primary care follow-up note.  I'm going to double-click the primary care note. And the primary care telephone note. 

Double-clicking each one of those notes added the notes to our list of preferred titles.  In addition, we see patients in a cardiology clinic a few days a week so we have a few titles that we use for cardiology clinic that we should add to our preferred titles list as well.  One of these cardiology note titles is a consult-specific title.  Using a consult title, as you recall, is linked to the consult request and this would update our consult request status to complete for us as well as send the results to the ordering provider. 

So I'm going to completely highlight the primary care telephone note that's in the document titles input box.

Now that I've done that, you can type in the word, "cardio." And now I will double-click the cardiology clinic note.  And I'll double-click the cardiology consult note.  

By the way, the reason you may want to add consult titles to your progress note titles preferred list is if you complete consults from the Progress Note tab in CPRS as opposed to completing consults via the Consults tab in CPRS.  It's just a great timesaver. The other thing we can do is to set one of our preferred note titles as our default title. So whenever we started a new note the default title would be initially selected for us. The way to do that is to simply highlight one of your preferred titles and then select the Set to Default button.  Since we see patients most often in primary care, let's default the primary care note title as our default.  Select the primary care note title within the list of titles. 

And then select the Set As Default button.   

Note at the top now, the list of titles primary care note is listed as our default.  This is where the setting that we set earlier under the Notes option called Verify Note Title comes into play.  If we did not have Verify Note Title enabled, since we now have a selected primary care note as our default title,  if we started a new note, the editor would immediately select that title and start the new note.  By having Verify Note Title enabled, even with a default title, it would be selected but would allow us to easily select a different title before the note editor opens.  We recommend having Verify Note Title always enabled.  Now I want you to remove the general note title. So select the general medicine note title.

And then select the Remove button.

Now we should default to consults documents class list of titles because we complete consults from the Consults tab.  We will have a quick predefined list of consult titles to choose from.  I will go up to the document class list box and I will select the down arrow button. Now please select the consults document class.  It's the second one in the list.

You may get a confirmation dialog asking if we want to save changes to our progress note defaults.  Select the Yes button.

Ah, now we have document titles that are specific to consult completion being listed for us to select as a preferred consult title list. Note that we already have an orthopedic surgery consult title predefined in our list.  We'll leave that.  We also complete consults for cardiology service so I'm going to double-click the cardiology consult note title. Now select the Save Changes button.

And finally select the OK button. 

What this does is if we complete a consult from the Consults tab in CPRS, we will be presented now with a list of our preferred consult note titles. A very nice timesaving tip. And that is how to set progress note preferences.  Select the OK button, which closes the Tools Options dialog.

I'd like to show you what we just did.  Go to the Notes tab. Select New Note.

Note the Progress Note Properties dialog now.  All of our preferred Note Titles are listed and our default title, the primary care note is selected and automatically highlighted for us.  But we could select another note title right here because of the Verify Note Title checkbox. We are not going to write a note.  So select the Cancel button.

A consult title warning will display.  Select the No button. And select Cancel again.

More customizing to do. Select the Tools menu. 

Select Options.

The last two tabs on the Options menu are for reports and graphs.  The tab for reports allows customization of the date ranges on the Reports tab in CPRS.  We already discussed this earlier.  

The final tab on the Options menu allows you to customize the graphing tool. The graphing tool could be a presentation in itself and there are other Web-based based training resources available on this topic. So that's it.  We've made it through the Tools Options menu.  In summary, CPRS is highly customizable and is a very usable electronic medical record. We hope you've enjoyed your time with us, touring tabby tab through CPRS.  We  have included a very short demonstration on how to use iMedConsent and VistA Imaging as well.  If you have time, check those out.
Topic 27:  VistA Imaging Display
For this portion of the presentation, I will demonstrate a program called VistA Imaging Display. VistA Imaging Display is a program that is used to view images that are part of the electronic medical record. The patient's medical record may have digital radiology images, scanned documents, digital images of wounds, retinal images, or other images as well attached as part of a diagnostic procedure such as a colonoscopy or an EKG. In addition, a patient's signed consent is also a digital image as part of the medical record. VistA Imaging Display will allows to view these images from our local medical center as well as images obtained from remote VA Medical Centers. As you recall from our CPRS presentation there is a visual indicator in the form of an icon which looks like a small picture that will display whenever a progress note or examination has a digital image attached. The VistA Imaging Display program allows you to view these images right on your computer.  The VistA Imaging viewer can be launched from the CPRS Tools menu.  First note that our CPRS session has CCOW patient context. I know this is indicated by the icon to the left of the patient's name. That represents a little blue person with an unbroken chain link.  If on the other hand, our CPRS session had a crowd of people with a broken chain link, I would not expect VistA Imaging to know about and automatically select my current CPRS patient. 

So let's select the Tools menu. 

About halfway down the list, select Image Display Viewer. The VistA Imaging Display program launches and automatically selected my CPRS patient for me.

VistA Imaging is CCOW-aware and as such will automatically choose our CPRS patient if possible.  Note that my VistA Imaging Display is not automatically connecting to the remote sites where this patient has been seen as indicated by the names of the medical centers bolded in red, which has a red line strikethrough. I have my VistA Imaging Display preference set to not automatically connect to remote sites. I'll talk about this VistA Imaging preference shortly.  

Let's connect to these remote sites by selecting the button labeled, Connect All.

Notice that the remote medical center names are now represented with green text and the line strikethrough is no longer there.  VistA Imaging has successfully connected to those medical centers. But even if the imaging software has connected, how do we know how many images, if any, are available at those remote sites? To find out how many images are available at each of those centers, select the icon that looks like two computers that are connected with a red arrow. And we can see that only the medical center that is reporting images is the Manchester VA Medical Center.  

Select the Close button.

Let's get a list of images that are available for us to view. There is an icon directly underneath the File menu that looks like a piece of paper with lines, which indicates a list. Please select that icon. An image list window displays informing us which sites the images are from, the title of the image, it's attached as a progress note, the procedure date and time, the procedure number of images, and a short description. In addition, since the ribs examination is highlighted, the imaging report for us displays as well at the bottom of the screen. Please select the colonoscopy procedure. It's the third one in the list.

An image of the colon displays as well as the colonoscopy report.  But there are actually four images as part of this procedure. To view the rest of those images we can open the abstract window.  Select the colonoscopy image, which is actually a group of images. And now we see the four images as part of this colonoscopy procedure group.  But we can also view the full resolution image by simply selecting the image. Select Image #2, that is the second one from the left. The full image displays as a Radiology Viewer window which allows us to change the brightness and contrast as well as zoom and image rotation.  

Close this window by selecting the X in the upper right-hand corner of the Radiology Viewer window. 

Let's review some EKG recordings.  

Select the icon that looks like an EKG tracing.

An EKG will display as well as a list of the available EKGs towards the right-hand side of the viewer window. Again, you can zoom in and also view the report directly from this window.  

Now close this window by selecting the X button in the upper right-hand corner.

Next, I would like to show you how to view a consent that has been entered into the electronic medical record by the iMedConsent program. Let's open the image listing window.  

Again select the icon that represents the image listing, that's the icon that looks like a list located directly underneath the File menu. The image window list displays.  

Select the informed consent/iMed entry.

The patient's consent for treatment for a skin lesion excision displays and we can easily scroll down this document to view the patient signatures if we needed to.  

Now close this window by selecting the X in the upper right-hand corner. Let me just show you some of the customization you can do with the VistA Imaging Display. In the Options menu, select View Preferences. The View Preferences window displays allowing you to customize whether you wish to automatically connect to remote sites, whether you wish to automatically see the abstracts or the image listing windows as well as other displays settings. Personally, I prefer to not have these checked because when I open VistA Imaging, I don't want a whole host of windows popping up automatically all over the place. I prefer to choose which window to open as needed. I also wish to choose when I want to connect to a particular remote medical center for those images. Anyways, this is where you can set your VistA Imaging Display preferences.  

Select the Close button.

And this concludes the basic presentation on how to use the VistA Imaging Display program.
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